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What do you think of this book? We want to hear from you! 
Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources
for you. To participate in a brief online survey, please visit: 

microsoft.com/learning/booksurvey
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 Introducing Microsoft Outlook 2010
Bill Gates’s dream of “a computer on every desktop” is becoming more and more of 
a reality—many people today work (and play) on computers both in the offi ce and at 
home. But desktop computers are even becoming a thing of the past. Laptops, net-
books, and other portable computers, as well as Windows Mobile devices, smartphones, 
Windows Phones, BlackBerries, and iPhones are becoming standard communication 
platforms. Electronic messaging—whether by e-mail, instant messaging, or text 
messaging—keeps many of us in contact with colleagues, clients, friends, and family 
members for a dizzying portion of each day. For people who are dependent on 
electronic messages as a means of communicating, Microsoft Outlook 2010 offers 
an ideal solution. Outlook 2010 includes not only e-mail functionality, but also inte-
grates with instant messaging programs and SMS text messaging service providers. 
Outlook enables you to manage messaging and information—address books, calen-
dars, task lists, note pads, and more—in one attractive interface. More importantly, 
Outlook makes this information immediately available to you when and where you 
need it. From one place, you can quickly store, organize, manage, and retrieve many 
types of information. You can use Outlook to:

● Send, receive, organize, and archive e-mail messages.

● Create attractive business graphics and incorporate and edit external images in 
your communications.

● Send documents, spreadsheets, graphics, and other fi les as message attachments, 
and preview attachments you receive from other people.

● Schedule events, appointments, and meetings, invite attendees, and reserve 
conference rooms, projectors, and other managed resources.

● View upcoming appointments and tasks, and receive reminders for them.

● Store contact information in a transferable and easily accessible format.

● Track tasks for yourself or for someone else, and schedule time to complete 
your tasks.

● Store random bits of information as notes.
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● Share schedule information with other people, inside and outside your organization.

● Track the interactions you have with other people.

● Organize and easily locate information in messages, attachments, calendars, contacts, 
and tasks.

● Filter out unwanted and annoying junk messages.

● Have information from favorite Web sites delivered directly to you.

In an enterprise environment, Outlook 2010 interacts with Microsoft server products 
to provide unifi ed communications services including real-time presence and status 
information, specialized functionality for internal messaging, access to facsimile mes-
sages and voicemail messages, offl ine access to SharePoint site content, and many 
other useful features. 

Signifi cant changes have been made from previous versions of Outlook. If you’re upgrading 
from Outlook 2007 or Outlook 2003, you might fi nd that some of the changes take a bit 
of getting used to—particularly the global incorporation of Offi ce 2010 interface elements 
such as the ribbon and the Quick Access Toolbar, and the new Backstage view. These 
elements have been carefully designed to provide intuitive access to tools and com-
mands. In Outlook 2010 you can control the content displayed on the ribbon tabs and 
personalize your working environment in more ways than in previous versions of 
Outlook. 

Let’s Get Started!
To put it simply, Outlook 2010 is a truly excellent one-stop information management 
system. Managing messages, schedules, and information is easier than ever before. After 
using this program for only a short time, you might wonder how you ever did without it. 
Join us now for a close look at all the features and functions of Outlook 2010.
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Modifying the Display of the Ribbon
The goal of the Microsoft Offi ce 2010 working environment is to make working with Offi ce 
fi les—including Microsoft Word documents, Excel workbooks, PowerPoint presentations, 
Outlook e-mail messages, and Access databases—as intuitive as possible. You work with 
an Offi ce fi le and its contents by giving commands to the program in which the document 
is open.  All Offi ce 2010 programs organize commands on a horizontal bar called the 
ribbon, which appears across the top of each program window whether or not there is 
an active document.

Ribbon tabs Ribbon groups

A typical program window ribbon.

Commands  are organized on task-specifi c tabs of the ribbon, and in feature-specifi c 
groups on each tab. Commands generally take the form of buttons and lists. Some 
appear in galleries. Some groups have related dialog boxes or task panes that contain 
additional commands. 

Throughout this book, we discuss the commands and ribbon elements associated with 
the program feature being discussed. In this topic, we discuss the general appearance 
of the ribbon, things that affect its appearance, and ways of locating commands that 
aren’t visible on compact views of the ribbo n.

See Also For detailed information about the ribbon in Microsoft Outlook, see “Working 
in the Outlook Program Window” and “Working with the Ribbon and the Backstage View” in 
Chapter 2, “Explore the Outlook Windows.”

Tip Some older commands no longer appear on the ribbon, but are still available in the 
program. You can make these commands available by adding them to the Quick Access 
Toolbar. For more information, see “Customizing the Quick Access Toolbar” in Chapter 13, 
“Customize Outlook.”
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Dynamic Ribbon Elements
The  ribbon is dynamic, meaning that the appearance of commands on the ribbon 
changes as the width of the ribbon changes. A command might be displayed on the 
ribbon in the form of a large button, a small button, a small labeled button, or a list 
entry. As the width of the ribbon decreases, the size, shape, and presence of buttons 
on the ribbon adapt to the available space.

For  example, when suffi cient horizontal space is available, the buttons on the Home tab 
of the Outlook program window are spread out and you’re able to see more of the 
commands available in each group.

Drop-down lists Large button Small labeled buttonsGallery

The Home tab of the Outlook program window at 1024 pixels wide.

If  you decrease the width of the ribbon, small button labels disappear and entire groups 
of buttons are hidden under one button that represents the group.  Click the group button 
to display a list of the commands available in that group.

Small unlabeled button Group button

The Home tab of the Outlook program window at 675 pixels wide.
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When  the window becomes too narrow to display all the groups, a scroll arrow appears 
at its right end. Click the scroll arrow to display hidden groups.

Gallery list Scroll arrow

The Home tab of the Outlook program window at 340 pixels wide.

Changing the Width of the Ribbon
The  width of the ribbon is dependent on the horizontal space available to it, which 
depends on these three factors:

● The width of the program window Maximizing the program window provides 
the most space for ribbon elements. You    can resize the program window by 
clicking the button in its upper-right corner or by dragging the border of a 
non-maximized window.

Tip On a computer running Windows 7, you can maximize the program window by 
dragging its title bar to the top of the screen.

● Your screen resolution Screen  resolution is the size of your screen display expressed 
as pixels wide × pixels high. The greater the screen resolution, the greater the 
amount of information that will fi t on one screen. Your screen resolution options 
are dependent on your monitor. At the time of writing, possible screen resolutions 
range from 800 × 600 to 2048 × 1152. In the case of the ribbon, the greater the 
number of pixels wide (the fi rst number), the greater the number of buttons that 
can be shown on the ribbon, and the larger those buttons can be.
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On a computer running Windows 7, you can change your screen resolution from 
the Screen Resolution  window of Control Panel. 

You set the resolution by dragging the pointer on the slider.

● The density of your screen display You   might not be aware that you can change 
the mag nifi cation of everything that appears on your screen by changing the 
screen magnifi cation setting in Windows. Setting your screen magnifi cation to 
125% makes text and user interface elements larger on screen. This increases the 
legibility of information, but means that less fi ts onto each screen.

On a computer running Windows 7, you can change the screen magnifi cation from 
the Display window of Control Panel.

See Also For more information about display settings, refer to Windows 7 Step by 
Step (Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or 
Windows XP Step by Step (Microsoft Press, 2002) by Joan Lambert Preppernau and 
Joyce Cox.
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You can choose one of the standard display magnifi cation options, or create another by 
setting a custom text size.

The   screen magnifi cation is directly related to the density of the text elements on 
screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms 
are interchangeable, and in fact are both used in the Windows dialog box in which 
you change the setting.) The greater the dpi, the larger the text and user interface 
elements appear on screen. By default, Windows displays text and screen elements 
at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text 
and screen elements to 120 dpi. You can choose a custom setting of up to 500% 
magnifi cation, or 480 dpi, in the  Custom DPI Setting dialog box.

You can choose a magnifi cation of up to 200% from the lists, or choose 
a greater magnifi cation by dragging across the ruler from left to right.
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Adapting Exercise Steps
The full-screen images shown in the exercises in this book were captured at a screen 
resolution of 1024 x 768, at 100% magnifi cation, and the default text size (96 dpi). If 
any of your settings are different, the ribbon on your screen might not look the same 
as the one shown in the book. For example, you might see more or fewer buttons in 
each of the groups, the buttons you see might be represented by larger or smaller 
icons than those shown, or the group might be represented by a button that you 
click to display the group’s commands.

When  we instruct you to give a command from the ribbon in an exercise, we do it in 
this format:

● On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, we give the instruction in this format:

● On the Page Layout tab, in the Page Setup group, click the Breaks button and 
then, in the list, click Page.

The fi rst time we instruct you to click a specifi c button in each exercise, we display an 
image of the button in the page margin to the left of the exercise step.

If  differences between your display settings and ours cause a button on your screen to 
look different from the one shown in the book, you can easily adapt the steps to locate 
the command. First, click the specifi ed tab. Then locate the specifi ed group. If a group 
has been collapsed into a group list or group button, click the list or button to display 
the group’s commands. Finally, look for a button that features the same icon in a larger 
or smaller size than that shown in the book. If necessary, point to buttons in the group 
to display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you 
read and work through the exercises in the book.

a05r626904.indd   xviiia05r626904.indd   xviii 6/13/14   10:47 AM6/13/14   10:47 AM



   xix

Features and Conventions 
of This Book

This book has been designed to lead you step by step through all the tasks you’re most 
likely to want to perform in Microsoft Outlook 2010. If you start at the beginning and 
work your way through all the exercises, you will gain enough profi ciency to be able to 
manage information by using Outlook and to create and work with e-mail messages, 
calendar items, and contact records. However, each topic is self contained. If you have 
worked with a previous version of Outlook, or if you completed all the exercises and 
later need help remembering how to perform a procedure,   the following features of 
this book will help you locate specifi c information:

● Detailed table of contents Scan the listing of the topics and sidebars within 
each chapter.

● Chapter thumb tabs Easily locate the beginning of the chapter by looking at the 
colored blocks on the odd-numbered pages.

● Topic-specifi c running heads Within a chapter, quickly locate a topic by looking 
at the running heads at the top of odd-numbered pages.

● Glossary Look up the meaning of a word or the defi nition of a concept.

● Keyboard Shortcuts If you prefer to work from the keyboard rather than with 
a mouse, fi nd all the shortcuts in one place.

● Detailed index Look up specifi c tasks and features in the index, which has been 
carefully crafted with the reader in mind.

You can save time when reading this book by understanding how the Step by Step series 
shows exercise instructions, keys to press, buttons to click, and other information. The 
following table lists these conventions.
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Convention Meaning
SET UP This paragraph preceding a step-by-step exercise indicates the 

practice fi les that you will use when working through the exercise. 
It also indicates any requirements you should attend to or actions 
you should take before beginning the exercise.

CLEAN UP This paragraph following a step-by-step exercise provides instructions 
for saving and closing open fi les or programs before moving on to 
another topic. It also suggests ways to reverse any changes you made 
to your computer while working through the exercise.

1
2

Blue numbered steps guide you through hands-on exercises in a 
topic.

1

2

Black numbered steps guide you through procedures in sidebars and 
expository text.

See Also This paragraph directs you to more information about a topic in this 
book or elsewhere.

Troubleshooting This paragraph alerts you to a common problem and provides 
guidance for fi xing it.

Tip This paragraph provides a helpful hint or shortcut that makes working 
through a task easier.

Important This paragraph points out information that you need to know to 
complete a procedure.

Keyboard Shortcut This paragraph provides information about an available keyboard 
shortcut for the preceding task.

Ctrl+B A plus sign (+) between two keys means that you must press those 
keys at the same time. For example, “Press Ctrl+B” means that you 
should hold down the Ctrl key while you press the B key.
Pictures of buttons appear in the margin the fi rst time the button is 
used in an exercise.

Interface objects In exercises that begin with SET UP information, the names of program 
elements, such as buttons, commands, windows, and dialog boxes, 
as well as fi les, folders, or text that you interact with in the steps, are 
shown in bold black type.

User input In exercises that begin with SET UP information, text that you should 
type is shown in bold blue type.
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Using the Practice Files
Before you can complete the exercises in this book, you need  to copy the book’s 
practice fi les to your computer. These practice   fi les, and other information, can be 
downloaded from the book’s detail page, located at:

http://go.microsoft.com/FWLink/?Linkid=192151

Display the detail page in your Web browser and follow the instructions for downloading 
the fi les.

Important The Microsoft Outlook 2010 software is not available from this Web site. You 
should purchase and install that software before using this book.

While working through the exercises in this book, you will use some practice fi les 
that we provide, and you will create Outlook items to use as practice fi les in later 
exercises. The following table lists the practice fi les you will use and create while 
working through the exercises in this book.

Chapter Use these fi les and items Create these fi les and items
Chapter 1:
Get Started with 
Outlook 2010

None None

Chapter 2:
Explore the 
Outlook Windows

None None

Chapter 3:
Send and Receive 
E-Mail Messages

We provide:
Brochure.docx
StrategySession.pptx

SBS First Draft message
RE: SBS First Draft message
FW: SBS First Draft message
SBS Tradeshow Schedule message

Chapter 4:
Store and Access 
Contact Information

None Contact records for Nancy 
Anderson, Andrew Davis, Sara 
Davis, Andrea Dunker, and Idan 
Rubin

Chapter 5:
Manage 
Scheduling

None SBS Lunch with Jane appointment
SBS Staff Meeting appointment
SBS Get Together meeting
SBS Pay Day event

(continued)
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Chapter Use these fi les and items Create these fi les and items
Chapter 6:
Track Tasks

You provide:
SBS First Draft message
SBS Tradeshow Schedule 
message

Flagged SBS First Draft message
Flagged SBS Tradeshow Schedule 
message
SBS Dinner Reservations task
SBS Order Brochures task
SBS Send Dinner Invitations task

Chapter 7:
Organize 
Your Inbox

You provide:
SBS First Draft message
FW: SBS First Draft message
RE: SBS First Draft message
SBS Tradeshow Schedule message

SBS Messages folder

Chapter 8:
Manage Your 
Calendar

None Secondary calendar

Chapter 9:
Work with Your 
Contact List

We provide:
JoanLambert.jpg
SBSContacts.txt

You provide:
Contact records for Nancy 
Anderson, Andrew Davis, Sara 
Davis, Andrea Dunker, and Idan 
Rubin 

SBS Contacts address book
SBS Litware address book
Contact records for Joel 
Lachance, Joan Lambert, Chris 
Mayo, Heidi Steen, Max Stevens, 
and Amy Strande
Clients contact group
Contact records for Eli Bowen, 
Liberty Munson, and Tjeerd 
Veninga

Chapter 10:
Enhance 
Message Content

We provide:
Lighthouse.jpg

Casual e-mail signature
SBS Development Cycle message 
and embedded SmartArt graphic 
SBS Picture Tools message and 
embedded modifi ed image

Chapter 11:
Manage E-Mail 
Settings

You provide:
SBS Messages folder

SBS Alert Test 1 message
SBS rule

Chapter 12:
Work Remotely

None None

Chapter 13:
Customize Outlook

None None
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 7 7   Organize Your Inbox   Organize Your Inbox
In this chapter, you will learn how to

✔ Work with Conversation view.
✔ Arrange messages in different ways.
✔ Organize Outlook items by using color categories.
✔ Organize messages in folders.
✔ Manage messages by using Quick Steps. 
✔ Quickly locate messages.
✔ Print messages.
✔ Delete messages.

You can use Microsoft Outlook 2010 to manage multiple e-mail accounts, including 
multiple Microsoft Exchange Server accounts with their associated contacts, calendars, 
and so on. Even if you use Outlook only for sending and receiving e-mail messages, 
you can rapidly build up a mass of messages that make it diffi cult to locate information. 
Fortunately, Outlook is designed to act as a complete information-management system; 
it provides many simple yet useful features that enable you to organize messages and 
other Outlook items and to quickly fi nd information that you need.

Outlook 2010 automatically handles certain types of organization for you. In your 
Inbox, Outlook makes it easy to follow related messages (message threads) from mul-
tiple people by displaying the messages in Conversation view. Outlook Search almost 
instantly locates items that contain specifi c content, and it allows you to save search 
results as Search Folders in which you can view up-to-date search results at any time.

You can organize items in Outlook by storing related items in folders and by assigning 
color categories to related items.

In this chapter, you’ll work with Conversation view to locate different levels of messages in 
a series. You’ll display the messages in your Inbox in a variety of arrangements and organize 
messages by assigning color categories and by moving them to folders within your Inbox. 
You’ll fi lter and fi nd messages by using the Search feature, and use Search Folders. You’ll 
work with the built-in Quick Steps. Finally, you’ll preview, print, and delete messages.
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232  Chapter 7 Organize Your Inbox

Practice Files The exercises in this chapter use Outlook items you created in exercises in 
previous chapters. If an exercise requires an item that you don’t have, you can complete 
the exercise in which you create the item before beginning the exercise, or you can 
substitute a similar item of your own. A complete list of practice fi les is provided in 
“Using the Practice Files” at the beginning of this book.

Working with Conversation View
Conversation  view is an arrangement of messages grouped by subject. All the messages 
with the same subject appear together in your Inbox (or other message list) under one 
conversation header. 

Message senders

Collapsed conversation headers

Unread messages

Until you expand the conversation header, the entire conversation takes up only as much space in 
your Inbox as a single message would. 

The  conversation header provides information about the messages within the conversation, 
including the number of unread messages and whether one or more messages includes an 
attachment, is categorized, or is fl agged for follow up.

When you receive a message that is part of a conversation, the entire conversation moves 
to the top of your Inbox and the new message appears when you click the conversation 
header. When a conversation includes unread messages, the conversation header is bold. 
When there are multiple unread messages, the number is indicated in parentheses follow-
ing the subject. The senders of the unread messages are listed below the subject.
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Split Conversations
When   an e-mail conversation involves more than two people, it frequently happens that 
more than one person responds to the same message, and other people respond to each 
of those messages. Multiple conversations emerge from the primary conversation in a 
process that you might think of as branches growing out from a tree—each can split 
into additional branches that are farther and farther from the trunk (the original message). 
A conversation that contains multiple branches is called a split conversation. Within a 
split conversation, individual conversation branches are marked by orange and gray 
dots. Larger orange dots indicate the most current message in each branch. Small 
orange dots indicate older messages. Small gray dots indicate messages that may be 
considered redundant.   Messages within each conversation branch are connected by 
orange and gray lines (referred to as visual threads). 

Tip Conversation view isn’t new in Outlook 2010—it was fi rst introduced in Outlook 2007—but 
it’s greatly improved and is now the default view for your Inbox and other message folders.

Viewing Conversations
You can display differing levels of messages within a conversation, as follows: 

● Click the conversation header or the    Expand Conversation button to the left of the 
conversation header once to display the most recent message in the Reading Pane 
and to display the most recent message in each branch of a split conversation in 
the message list. These messages are indicated by orange dots.

Click the conversation header once to display only the most recent messages.
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● Click  the conversation header again to expand the conversation to display all 
messages in the conversation.

Sent message

Expanded conversation

Current split
conversation message

Click the conversation header twice to display all messages.

● Click the most recent message in a split conversation to display the visual thread 
of that message branch.

Click a message to display its visual thread.

Conversation View Settings
By default,  Conversation view displays messages stored in any folder, including sent 
messages that are stored in the Sent Items folder. (Within the expanded conversation, 
sent messages are indicated by italic font.) If you prefer to display only messages from 
the current folder, you can clear this setting on the Conversation Settings menu in the 
Conversation group on the View tab.
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Other settings that you can turn on include:

● Show Senders Above the Subject This  setting reverses the order of the information 
in the conversation header; you see the names of the conversation participants 
above the conversation subject. In some cases, such as when Outlook displays a 
message on the second line, the subject might not be visible at all.

The effect of the Show Senders Above The Subject setting in a split conversation.

● Always Expand Conversations This setting causes Outlook to display all messages 
in a conversation when you click the conversation header once, rather than twice.

● Use Classic Indented View This   setting causes Outlook to indent older messages 
within individual message threads to show the progression of the thread. This 
setting is not as effective as the default for displaying split conversations because 
a message might be at the root of multiple branches but can appear only once in 
the message list.

The effect of the Use Classic Indented View setting.

Managing Conversations
Although   the most apparent function of Conversation view is the grouping of related 
messages, its greatest usefulness is as a message-management tool. It can be especially 
handy for Outlook users within large organizations that use distribution lists to dis-
seminate information to a large group of people. When hundreds of message recipients 
use the Reply All function to respond to a message, your Inbox can quickly become 
cluttered. 
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Troubleshooting Conversation View

As with many “new and improved” features, Conversation view has its fans and 
its detractors. Many Outlook users appreciate the effi ciency of the automatically 
grouped messages and not having to wade through as many messages in their 
Inboxes; others rue the fact that this new feature can cause messages to vanish, 
apparently, from their Inboxes before they’ve even seen them.

Conversation view can present a very effi cient means of viewing messages within a 
multi-threaded conversation; however, it also has its drawbacks. Because Conversation 
view displays only certain messages within a conversation, a specifi c message that 
you’re looking for might not be visible within a conversation.  If this happens, you can 
turn off Conversation view (by clearing the Show In Conversations check box in the 
Conversation group on the View tab) and then use one of these methods to locate 
the message you want to fi nd:

● Sort  the messages by subject, and then type the fi rst few letters of the con-
versation subject to scroll those messages to the top of the Message pane.

● Enter the subject into the Search box at the top of the Message pane and then 
specify any other criteria (such as the sender or date) of the message that you’re 
looking for to narrow the results. 

After using either of these methods to display a set of messages, visually scan the 
messages to locate the one you’re looking for.

Conversation view enables you to manage all the messages within a conversation as a group. 
You  can do this by clicking the conversation header to effectively select all the messages in 
the conversation (they won’t appear selected, but any action you apply to the conversation 
header applies to all the individual messages in the conversation) and then applying your 
action. Or you can use these new conversation-management tools:

● Ignore Conversation This    command moves the selected conversation and any 
related messages you receive in the future directly to the Deleted Items folder.

Keyboard Shortcut Press  Ctrl+Del to ignore the currently active conversation.

See Also For more information about keyboard shortcuts, see “Keyboard Shortcuts” 
at the end of this book.

Tip Be cautious when using the Ignore Conversation command. Outlook identifi es 
“conversations” based on message subjects. If you receive unrelated messages in the 
future that have the same message subject as a conversation that you’ve chosen to 
ignore, you won’t receive those messages.
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● Clean Up Conversation This    command deletes redundant messages—messages 
whose text is wholly contained within later messages—from a conversation. By 
default, Outlook doesn’t clean up categorized, fl agged, or digitally signed mes-
sages. You can modify conversation clean-up settings on the Mail page of the 
Outlook Options dialog box.

See Also For information about modifying mail settings, see “Personalizing Your Offi ce 
and Outlook Settings” in Chapter 13, “Customize Outlook.”

Arranging Messages in Different Ways
As the number of messages in your Inbox increases, it can be challenging to keep track 
of them. You can arrange, group, and sort messages in Outlook to help you quickly 
determine which are the most important, decide which can be deleted, and locate 
any that need an immediate response.

See Also For information about the available message folder views, see “Viewing Messages 
and Message Attachments” in Chapter 3, “Send and Receive E-Mail Messages.”

You  can view a message list in Compact view, Single view, or Preview view. Regardless 
of the view you’re displaying, you can arrange messages and conversations within the 
message list by choosing a standard arrangement from the Arrangement gallery on 
the View tab.

The Arrangement gallery.

Alternatively,   you can click the Arrange By bar at the top of the message list and then 
click an option in the Arrange By list.
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Message list header
Sort order

The Arrange By list.

Two options that affect the way messages appear within an arrangement are conversations 
and grouping. Both of these organizational options are turned on by default; you can turn 
either or both off.

See Also For information about conversations, see “Working with Conversation View” earlier 
in this chapter.

Grouping   gathers messages that fi t within specifi c arrangement categories under 
arrangement-specifi c headings so that you can manage common messages as one. 
For example, when messages are arranged by date, they are grouped by date: groups 
include each day of the current week, Last Week, Two Weeks Ago, Three Weeks Ago, 
Last Month, and Older. 

Each group has a header. You  can expand or collapse an individual group by clicking the 
arrow to the left of the group name in the header. You can collapse the group containing 
the currently selected item by pressing the Left Arrow key, and you can expand a selected 
group by pressing the Right Arrow key. You can expand or collapse all groups by choosing 
a command from the Expand/Collapse list in the Arrangement group on the View tab.
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By default,      Outlook displays messages arranged by date, from newest to oldest. 
Alternatively, you can arrange items by any of the following attributes:

● Account Messages are grouped by the e-mail account to which they were sent. 
This is useful if you receive messages for more than one e-mail account in your 
Inbox (for example, if you receive messages sent to your POP3 account within 
your Exchange account mailbox).

● Attachments Messages are grouped by whether they have attachments and 
secondarily by date received.

● Categories Messages are arranged by the category you assign them to. Messages 
without a category appear fi rst. Messages assigned to multiple categories appear 
in each of those category groups.

● Flag: Start Date or Due Date Unfl agged messages and messages without specifi c 
schedules appear fi rst. Messages that you’ve added to your task list with specifi c start 
or due dates are grouped by date.

● From Messages appear in alphabetical order by the message sender’s display name. 
If you receive messages from a person who uses two different e-mail accounts, or 
who sends messages from two different e-mail clients (for example, from Outlook 
and from Windows Mail), the messages will not necessarily be grouped together.

● Importance Messages are grouped by priority: High (indicated by a red exclamation 
point), Normal (the default), or Low (indicated by a blue downward-pointing arrow).

● To Messages are grouped alphabetically by the primary recipients (the addresses 
or names on the To line). The group name exactly refl ects the order in which 
addresses appear on the To line. Therefore, a message addressed to Bart Duncan; 
Lukas Keller is not grouped with a message addressed to Lukas Keller; Bart Duncan.

● Size Messages are grouped by the size of the message, including any attachment. 
Groups include Huge (1–5 MB), Very Large (500 KB–1 MB), Large (100–500 KB), 
Medium (25–100 KB), Small (10–25 KB), and Tiny (less than 10 KB). This feature is use-
ful if you work for an organization that limits the size of your Inbox because you can 
easily locate large messages and delete them or move them to a personal folder.

● Subject Messages are arranged alphabetically by their subjects and then by date. 
This is similar to arranging by conversation except that the messages aren’t threaded.

● Type Items in your Inbox (or other folder) are grouped by the type of item—for 
example, messages, encrypted messages, message receipts, meeting requests and 
meeting request responses, tasks, Microsoft InfoPath forms, and server notifi cations.
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After   arranging the items in your message list, you can change the sort order of the 
arrangement by clicking the sort order indicator that appears on the right side of 
the message list header.

Regardless of the view and arrangement you choose, you can sort messages by any 
visible column simply by clicking its column heading (and reverse the sort order by 
clicking the column heading a second time).    You can change the displayed columns from 
the Show Columns dialog box, which you display by clicking the Add Columns button 
in the Arrangement group on the View tab.

The Show Columns dialog box.

Outlook displays the selected columns in the order shown in the list on the right side of 
the Show Columns dialog box. If displaying all the columns requires more space than is 
available, only some of the columns will be visible. If necessary, you can change the 
number of lines shown to accommodate more columns. However, you are likely to fi nd 
that one of the standard views fi ts your needs.

In a list view, you can control the message arrangement, sorting, grouping, visible col-
umns, and other settings from the shortcut menu that appears when you right-click any 
column header.
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In this exercise, you’ll change the arrangement, sort order, and grouping of messages in 
your Inbox, and fi lter the Inbox content to display only specifi c messages. Then you’ll 
restore the default settings. 

SET UP You don’t need any specifi c practice fi les to complete this exercise; just 
use the messages in your Inbox. Display your Inbox in Messages view, and then 
follow the steps.

 1. In the Arrangement gallery, click From.

Outlook      rearranges and groups the messages in your Inbox alphabetically by sender.

The Sort Order indicator changes to match the selected arrangement.

 2. In the message list header, click A on top.

Outlook   reverses the order of the messages and changes the sort order in the 
message header to Z On Top.
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 3. In the message list header, click the Arrange By bar, and then click Subject.

Outlook rearranges and groups the messages by subject, in alphabetical order.

 4. In    the Arrangement group, click the Expand/Collapse button and then, in the list, 
click Collapse All Groups.

Only the group headers are visible. There is a group header for each message or 
set of messages with the same subject.

Collapsing groups of messages displays only the group headers. 

Notice that the number of unread items in each group (if there are any) is indicated 
in parentheses following the conversation subject.

 5. On the Home tab, in the Find group, click the    Filter E-mail button.

The Filter E-mail list expands. The list contains the same options that are present 
on the Search contextual tab.

In the Filter E-mail list, you can specify one or more criteria for the messages that are 
shown in the message list.
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 6. In   the Filter E-mail list, click Unread.

Outlook enters the specifi ed fi lter in the Search box at the top of the message list 
and fi lters your Inbox to display only unread messages. (If you have no unread 
messages in your Inbox, it appears to be empty.)

The Search box and Search contextual tab indicate the applied fi lter.

Troubleshooting The appearance of buttons and groups on the ribbon changes 
depending on the width of the program window or item window. For information 
about changing the appearance of the ribbon to match our screen images, see 
“Modifying the Display of the Ribbon” at the beginning of this book.

 7. On the Search tab, in the Close group, click the   Close Search button.

Outlook removes the fi lter and returns to the previous arrangement.

 8. Experiment with the available arrangement, sorting, and grouping options.

 9. On the View tab, in the Current View group, click the  Reset View button. Then in 
the Microsoft Outlook dialog box that asks whether to reset the view, click Yes.

The message list returns to its original arrangement: grouped, by date, in 
conversations.

CLEAN UP Arrange your Inbox content in the way that works best for you. Retain 
the default view settings before continuing, if you want them to match those 
shown in the rest of this book.
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Marking Messages as Read or Unread
When    a new message arrives in your Inbox, its header is bold and its icon depicts a 
closed envelope to indicate that you haven’t yet opened the message—its status is 
unread. When you open a message in a message window or preview it for a certain 
length of time in the Reading Pane, its status changes to read. The message header 
is no longer bold, and its icon depicts an open envelope.

You might want to change the status of a message from read to unread, to remind you 
to revisit it, or from unread to read, if you know from the message subject that you don’t 
need to take action on it.

You can manually change the status of a message by using these methods:

● Click a message in the message list or select multiple messages, and then on 
the Home tab, in the Tags group, click the  Unread/Read button.

● Right-click a message or one of a group of selected messages in the message 
list, and then click Mark As Read or Mark As Unread.

Tip The shortcut menu that appears when you right-click an item shows only the 
available option.

● Right-click a folder in the Navigation Pane, and then click Mark All As Read.

Keyboard Shortcuts Press Ctrl+Q  to mark a message as read. Press Ctrl+U to mark a 
message as unread.

Organizing Outlook Items by Using Color Categories
To  help you more easily locate Outlook items associated with a specifi c subject, project, 
person, or other condition, you can create a category specifi c to that condition and assign 
the category to any related items. You can assign a category to any type of Outlook item—
a message, an appointment, a contact record, a note, and so on. For example, you might 
assign contact records for customers to a Customers category. 

Outlook  uses color categories, which combine named categories with color bars to 
provide an immediate visual cue when you view messages in your Inbox, appointments 
on your calendar, and so on. Depending on the view of the Outlook items, the category 
may be indicated by a simple colored block or a large colored bar.
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Category bars

Category blocks

Category bars include the category name.

Tip You can locate, sort, and fi lter Outlook items by category. For information, see “Quickly 
Locating Messages” later in this chapter.

Outlook 2010 comes with six pre-confi gured color categories that are associated only with 
the color names. You can rename the six starting categories and create new categories. 
Each category can have the following elements:

● Name The  category name can be one simple word or a long, descriptive phrase. 
The fi rst 32 characters of the category name are visible in the color categories 
dialog box, but pointing to a truncated name displays a ScreenTip containing 
the entire name.

● Shortcut key You   can assign any of the 11 available keyboard shortcut combinations 
(CTRL+F2 through CTRL+F12) to a color category. (You can assign only these 11 
keyboard shortcuts within the dialog box.) By using a keyboard shortcut, you can 
assign a frequently used category in one step.

● Color You  can assign any of the 25 available colors to a category, or you can 
choose not to assign a color. (You can’t choose colors other than the 25 shown.) 
When you assign a category that doesn’t have an associated color to an Outlook 
item, the color block or color bar is shown as white. You can assign one color to 
multiple categories.
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You can assign any of 25 colors to a category.

One category is designated as the    Quick Click category. Outlook assigns the Quick Click 
category by default when you simply click the Category box or column associated with 
an item. You can change the Quick Click category by clicking Set Quick Click on any one 
of the Categorize menus and then making your selection in the Set Quick Click dialog 
box that appears.

The Quick Click category is applied by default when you click a Category bar.

Tip You can also set the Quick Click category on the Advanced page of the Outlook Options 
dialog box. For more information, see “Personalizing Your Offi ce and Outlook Settings” in 
Chapter 13, “Customize Outlook.”

You can apply a color category to a selected item or items by using any of these methods:

● In any mail or contacts folder, click the   Categorize button in the Tags group on the 
Home tab, and then in the list, click the category you want.

● In any message list, click in the Categories column to assign the    Quick Click category.

● In any calendar, click the Categorize button in the Tags group on the contextual tab 
(Appointment, Meeting, and so on) that appears for the selected item, and then 
click the category you want.

● In any folder,  right-click an item or a selection of items, point to Categorize, and 
then click the category you want.
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To quickly view the messages belonging to a category, you can group messages by 
category or include the category in a search. In a list view of any module, you can sort 
and fi lter by category. On the To-Do Bar, you can arrange your fl agged messages and 
tasks by category.

Tip You can instruct Outlook to automatically assign a category to an incoming message that 
meets specifi c criteria by creating a rule. For more information, see “Creating Rules to Process 
Messages” in Chapter 11, “Manage E-Mail Settings.”

In this exercise, you’ll change the name and color of an existing category, assign a shortcut 
key to a category, and create categories. Then you’ll categorize a message, and experiment 
with organizing your Inbox contents by using categories.

SET UP You need the SBS Tradeshow Schedule, SBS First Draft, RE: SBS First Draft, 
and FW: SBS First Draft messages you created in Chapter 3, “Send and Receive 
E-Mail Messages.” If you have not already created these messages, you can do so 
now, or you can substitute any messages in your Inbox. Display your Inbox, and 
then follow the steps.

 1. In the message list, click the SBS Tradeshow Schedule message.

 2. On the Home tab, in the Tags group, click the  Categorize button.

The Categorize list displays the available categories.  Notice that you can remove 
all categories from a selected message or group of messages by clicking Clear All 
Categories.

If you haven’t yet worked with categories, the Categorize list includes only the six standard 
categories named for their colors.
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3. In the Categorize list, click All Categories.

The  Color Categories dialog box opens, displaying the currently available 
categories.

You can rename any of the standard color categories or create new color categories.

 4. In  the Color Categories dialog box, click the Blue Category name (not the check 
box), and then click Rename.

Troubleshooting If you have already renamed the standard categories, you can either 
create or rename a different category.

 5. With the category name selected for editing, type Management, and then press 
Enter.

Troubleshooting Don’t click OK—doing so closes the dialog box.

The category name changes. The category order doesn’t immediately change, 
but the next time you display the categories in a list or dialog box, they are 
reordered alphabetically.

Tip If you don’t rename a standard color category before assigning it for the fi rst time, 
Outlook gives you the option of renaming the category the fi rst time you use it.

 6. With  the Management category still selected, click the Color arrow, and then in 
the lower-right corner of the color palette, click the Dark Maroon square.

The color associated with the Management category changes from Blue to Dark 
Maroon.

 7. Repeat steps 4 and 5 to rename the Orange Category as Travel Required.
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 8. In  the Color Categories dialog box, click New.

The Add New Category dialog box opens.

 9. In the Name box, type Marketing. Click the Color arrow and then, in the color 
palette, click the Dark Green square. Then click the Shortcut Key list.

The list expands to display the keyboard shortcuts available to color categories.

Assign keyboard shortcuts to categories that you use frequently, to save time.

 10. In   the Shortcut Key list, click CTRL+F2. Then in the Add New Category dialog 
box, click OK.

The new category appears at the bottom of the color categories list. Its selected 
check box indicates that it has been assigned to the currently selected message.

 11. In  the Color Categories dialog box, click the Green Category name (not the check 
box), and then click Delete. In the Microsoft Outlook dialog box confi rming that 
you want to delete the category, click Yes.

Keyboard Shortcut Press  Alt+D to delete the selected category from the color 
categories dialog box.

The Green Category disappears from the list.

 12. In the Color Categories dialog box, click OK.

In    the message list and in the To-Do Bar Task List, the Category box of the selected 
message changes to a dark green square. In the Reading Pane, a dark green bar 
with the category name Marketing appears at the top of the message.
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 13. In the SBS Tradeshow Schedule message header, right-click the Category box.

The shortcut menu displays the color category options in alphabetical order.

Right-clicking any Category box displays the Categorize list content.

 14. On the shortcut menu, click Travel Required.

The second category box appears in the message header and in the To-Do 
Bar Task List.

Tip You   can assign an unlimited number of categories to a message, but only the 
three most recently assigned appear in the message header.

The Reading Pane displays two colored category bars. If you assign more than 
three categories to a message, Outlook displays additional rows of category bars.

Category bars

Assigned categories are visible in the message list, Reading Pane, and To-Do Bar. 

 15. In the message list, expand the SBS First Draft conversation twice to display its 
messages. Click any message in the conversation, and then press Ctrl+F2.
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The Marketing category is assigned to the selected message and also appears 
in the conversation header.

 16. Click another message in the SBS First Draft conversation. On the Home tab, in the 
Tags group, click the Categorize button and then, in the list, click Management.

The Management category is assigned to the selected message, and also appears 
as a second category in the conversation header.

 17. In   the message list header, click the Arranged By bar and then, in the list, click 
Categories.

The messages are arranged by category, beginning with the uncategorized messages 
(None), followed by the categorized messages in alphabetical order by category.

 18. To the right of the Arranged By bar, click A on top.

The sort order reverses to display the categorized messages (in reverse alphabetical 
order) at the top of the list.

You can quickly locate categorized messages by changing the message list arrangement.

CLEAN UP Return the message list to its default Date arrangement before continuing 
to the next exercise. Retain the SBS Tradeshow Schedule, SBS First Draft, RE: SBS First 
Draft, and FW: SBS First Draft messages for use in later exercises.
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Recording Information by Using Outlook Notes

You can store miscellaneous information such as reminders, passwords, account 
numbers, and processes by recording them as electronic notes. Because your 
notes are available to you from wherever you access Outlook, this can be a very 
convenient way of retaining information you might need later. And because 
you’re less likely to accidentally delete a note than a message, it is safer than 
sending information to yourself in an e-mail message.

Although notes are a type of Outlook item, they don’t appear in the same type 
of windows as messages, appointments, contact records, and tasks. Instead, they 
appear in the form of “sticky notes” resembling the popular 3M-brand Post-It 
notes. You can view, sort, and organize notes in the same way you do other 
Outlook items. The standard views include:

● Icons

● Notes List

● Last Seven Days

You switch the view by clicking the View you want in the Current View gallery on 
the Home tab. If you’re looking for a specifi c piece of information in a note, you 
can quickly locate it by typing a search word or phrase in the Search Notes box 
above the content pane.

By default, the Reading Pane is hidden in the Notes pane, but if you prefer, you 
can display the Reading Pane and view the content of notes without opening 
them. To do so, click the Reading Pane button on the View tab, in the Layout 
group, and then click Right or Bottom to display the Reading Pane in that 
location.

You can enter only text into a note; you can’t format the text. If you paste formatted 
text into a note, it will change to the default font. 
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Tip Notes do support hyperlinks; if you enter a Web site address and then press 
Enter, the Web site address will change to blue, underlined text to indicate that 
it is a hyperlink. You can click the hyperlink to open the Web site or page in your 
default Web browser.

By default, note icons and sticky note representations are a pale yellow color, like 
the color of standard paper sticky notes. When you assign a category to a note, the 
note color changes to the category color.

You can change the default note color (you have the choice of white or a pastel 
shade of blue, green, pink, or yellow), size (small, medium or large), or font (any 
font installed on your computer) from the Notes and Journal page of the Outlook 
Options dialog box.

To store information in a note:

 1. In the Navigation Pane, click the Notes button.

Outlook displays the Notes pane.

 2. On the Home tab, in the New group, click the New Note button.

Outlook displays a new note. The current date and time appear at the 
bottom.

 3. Enter the subject or title of the note, press Enter, and then enter the information 
you want to store into the note. 

The fi rst line of the note becomes its subject or title.

 4. To save and close the note, click the Close button in the upper-right corner.

The note appears in the Notes pane. Only the subject is visible. You can 
access the stored information by opening the note (or by displaying the 
Reading Pane).
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Organizing Messages in Folders
After  you’ve read and responded to messages, you might want to keep some for future 
reference. You can certainly choose to retain them all in your Inbox if you want, but 
as the number of messages in your Inbox increases to the hundreds and even into the 
thousands, it might quickly become overwhelming. To keep your Inbox content low and 
avoid an accumulation of unrelated messages, you can organize messages into folders. 
For example, you can keep messages that require action on your part in your Inbox and 
move messages that you want to retain for future reference into other folders.

Tip Because the Outlook Search function provides the option of searching within all folders 
containing items of a particular type, you can easily locate a message that’s been moved to 
a folder without having to remember exactly which folder it’s in. For more information, see 
“Quickly Locating Messages” later in this chapter.

Popular personal-organization experts advocate various folder structures (for paper 
folders as well as for e-mail message folders) as an important part of an organizational 
system. You can apply any of these ideas when you create electronic folders in Outlook, 
or you can use any other structure that works for you. For example, you might create a 
folder for each project you’re working on and store all messages regarding a particular 
project in its own folder. Or you might create a folder to store all messages from a par-
ticular person, such as your manager, regardless of the message subject.

When you create a folder, you specify the location of the folder within your existing 
Outlook folder structure and the type of items you want the folder to contain.  You can 
create folders to contain the following types of items:

● Calendar items

● Contact items

● InfoPath Form items

● Journal items

● Mail and Post items

● Note items

● Task items

The selection you make governs the folder icon that precedes its name in the folder list, the 
folder window layout, the ribbon tabs and commands available in the folder, and the con-
tent of the Navigation Pane in the folder.
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You can move messages to folders manually, or if your organization is running 
Exchange, you can have Outlook move them for you. You can automatically move 
messages to another folder by creating a rule—for example, you can instruct Outlook 
to automatically move all messages received from your manager to a separate folder. 
You can set up different rules that go into effect when you’re away from the offi ce.

See Also For information about automatically moving messages, see “Creating Rules to 
Process Messages” in Chapter 11, “Manage E-Mail Settings.”

In this exercise, you’ll create a folder and then use different methods to move messages 
to the folder.

SET UP You need the SBS First Draft, RE: SBS First Draft, and FW: SBS First Draft 
messages you worked with in the previous exercise. If you have not already created 
these messages, you can do so now, or you can substitute any messages in your 
Inbox. Display your Inbox, and then follow the steps.

 1. On the Folder tab, in the New group, click the   New Folder button.

Keyboard Shortcut Press  Ctrl+Shift+E to create a new folder.

The  Create New Folder dialog box opens.

The default settings in the Create New Folder dialog box match the active module at the 
time you create the folder.
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Troubleshooting If your default data fi le (the fi le in which your messages are stored) 
is a personal folder on your hard disk, the fi rst item in the Select Where To Place The 
Folder box is Personal Folders.

 2. In  the Name box, type SBS Messages. In the Select where to place the folder 
box, click Inbox. Then, with Mail and Post Items selected in the Folder contains 
list, click OK.

Tip The name of this folder begins with SBS so that you can easily differentiate it from 
other folders in your mailbox.

Because you created this folder from the Inbox, Outlook creates the new folder as a 
subfolder of the Inbox, and formats it to contain mail items.

The new folder will display the ribbon tabs of the Mail module because you designated 
that it will contain Mail items.

3. In the message list, locate the SBS First Draft, RE: SBS First Draft, and FW: SBS 
First Draft messages.

 4. Drag  the SBS First Draft message from the message list to the SBS Messages 
folder in the Navigation Pane.

The message moves from the Inbox to the SBS Messages folder.

 5. Click the RE: SBS First Draft message to select it. Then on the Home tab, in the 
Move group, click the  Move button.

The Move list expands, displaying a list of folders and other move options.
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The Move list automatically includes folders that you create.

 6. In  the Move list, click SBS Messages.

The selected message moves from the Inbox to the SBS Messages folder.

 7. Right-click the FW: SBS First Draft message, click Move, and then click SBS Messages.

The conversation disappears from the Inbox. 

Tip When  you move the last message of a conversation from the Inbox, related messages 
stored in other folders disappear.

 8. In the Navigation Pane, under the Inbox folder, click the SBS Messages folder.

The messages are visible in the new folder as part of a conversation.

 9. Expand the conversation header once.

All the messages in the conversation are visible in the list.

Messages that aren’t in the current folder are shown in italics. 

CLEAN UP Retain the SBS Messages folder and its contents for use in later exercises.
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Managing Messages by Using Quick Steps
A convenient new feature of Outlook 2010 is Quick Steps, which allow you to perform 
multiple tasks on messages by clicking only one button. Quick Steps are available from 
the Quick Steps gallery on the Home tab of any mail folder.

The default Quick Steps gallery.

You can use the built-in Quick Steps or create your own to accomplish as many as 12 
tasks at once.

A default Outlook installation includes these fi ve Quick Steps:

● Move To Moves   the selected message to a folder that you specify the fi rst time you 
use the Quick Step and marks the message as read. After you specify the folder, the 
Quick Step name changes to include the folder name.

● Team E-mail Creates    a message to a person or people you specify the fi rst time you 
use the Quick Step. You can edit the Quick Step to include Cc and Bcc recipients, a 
specifi c message subject, a follow-up fl ag, a level of importance, and specifi c mes-
sage text, and to automatically send the message one minute after you click the 
Quick Step command.

● Reply & Delete Creates     a response to the original message sender and immediately 
deletes the original message.

Troubleshooting The Reply & Delete Quick Step deletes the original message before 
you send the reply. If you close the response message composition window without 
sending it, the original message will no longer be in your Inbox. If you want to respond 
to the original message, you fi rst need to retrieve it from your Deleted Items folder.

● To Manager Forwards  the selected message to a person or people you specify the 
fi rst time you use the Quick Step. You can edit the Quick Step to include Cc and Bcc 
recipients, a specifi c message subject, a follow-up fl ag, a level of importance, and 
specifi c message text, and to automatically send the message one minute after you 
click the Quick Step command.

● Done Moves  the selected message to a folder that you specify the fi rst time you use 
the Quick Step, marks the message as read, and marks the message as complete so 
that a check mark is displayed in the follow-up fl ag location.
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For each of the built-in Quick Steps, you can change its name; edit, add, and remove 
actions; and specify tooltip text that appears when you point to the Quick Step in the 
Quick Steps gallery. You can assign shortcut keys (Ctrl+Shift+1 through Ctrl+Shift+9) to 
up to nine Quick Steps.

Tip You can create new Quick Steps to simplify the performance of many types of message-
management actions. For more information, see “Creating and Managing Quick Steps” in 
Chapter 13, “Customize Outlook.”

In this exercise, you will set up and use a built-in Quick Step.

SET UP Use the SBS Tradeshow Schedule message you worked with earlier in this chapter 
and the SBS Messages folder you created in the previous exercise. If you did not create 
these practice fi les, you can do so now or substitute any message and folder in your 
Inbox. Display your Inbox, locate the SBS Tradeshow Schedule message, and then 
follow the steps.

 1. On the Home tab, in the Quick Steps gallery, click Move to: ?.

The  First Time Setup dialog box for the selected command opens.

Some generic Quick Steps require that you supply information the fi rst time you use them.

 2. Click the Move to folder arrow and then, in the list, click SBS Messages.

In the Name box, the name of the Quick Step changes from Move To: ? to SBS 
Messages.

 3. In the First Time Setup dialog box, click Options.

The   Edit Quick Step dialog box opens.
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The Move To command doesn’t include many standard options.

Notice that you can change the existing actions (Move To Folder and Mark As 
Read) and add actions to the standard Quick Step.

 4. In the Tooltip text box, select the existing text and then type Move and mark 
as read.

 5. In the Edit Quick Step dialog box, click Save.

In the Quick Step gallery, the Quick Step name changes from Move To: ? to SBS 
Messages.

 6. In the message list, click the SBS Tradeshow Schedule message to select it.

 7. In  the Quick Steps gallery, point to SBS Messages.

Your custom tooltip appears below the ribbon.
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You can supply custom tooltip text for any Quick Step.

 8. In the Quick Steps gallery, click SBS Messages.

The selected message disappears from the message list.

 9. In  the Navigation Pane, under the Inbox folder, click the SBS Messages folder.

The message has been moved to the designated folder. 

The categories and follow-up fl ag of the moved message are intact.

CLEAN UP Retain the SBS Messages folder and its contents for use in later exercises.

Quickly Locating Messages
The Outlook Search feature   is based on the Windows Search technology that is built into 
Windows 7 and Windows Vista Service Pack 2. Using the Windows Search technology, 
you can fi nd any fi le on your computer that contains a specifi ed search term—whether 
in a fi le or folder name, in document or workbook content, in an e-mail message within 
Outlook, in a message attachment, in a picture, music, or video fi le, and so on. (As a 
matter of fact, if you prefer to do so, you can conduct all of your Outlook searches from 
the Windows Start menu.)
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You can use the Search feature to locate specifi c terms in any Outlook item. Although you 
can search for items in the Calendar, Contacts, Tasks, and Notes modules, you most often 
use it to locate messages in your Inbox and other mail folders. The Search feature can 
locate search terms in a message or in a fi le attached to a message. As you enter a search 
term in the Search box located at the top of the content pane in any module, Outlook 
fi lters the items to show only those items in the module that contain the search term and 
highlights the search term in the list of results.

If  the search term you enter produces more than 200 results, only the fi rst 200 are 
displayed, and an information bar appears in the Search Results pane.

Search displays only the fi rst 200 available results unless you request more.

You   can display all the results for the current search term by clicking the message bar, 
or you can narrow the results by expanding the search term or by specifying   other 
search criteria, such as the sender, the recipient (whether the message was addressed 
or only copied to you), a category assigned to the item, whether the message contains 
attachments, and so on.

Outlook 2010 features the Search contextual tab. This ribbon tab appears when you 
activate the Search box in any Outlook module. You can enter search terms into the 
Search box and refi ne your search by using the commands on the Search contextual tab.

The Search tab appears when you click in a Search box or fi lter the contents of a message folder.

When searching any folder, you can use the commands on the Search tab to set the 
scope of the search and to more closely defi ne the search specifi cations. You can also 
return to the results of previous searches.

See Also For information about Windows 7 search features, refer to Windows 7 Step by Step 
by Joan Lambert Preppernau and Joyce Cox (Microsoft Press, 2009).
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The buttons available in the Scope and Refi ne groups vary based on the type of folder 
you’re searching. The Scope group always offers the options of the current folder, all 
subfolders, all folders of the current type, and all Outlook items. The commands in the 
Refi ne group change to refl ect common properties of items stored in the current folder 
type. The most common properties are shown as buttons in the Refi ne group; additional 
properties are available for selection from the More list.

You can search for an item based on any property.

When  you click a button in the Refi ne group or a property in the More list, that property 
appears in the Search box with a placeholder for you to specify the value you’re looking 
for. As you defi ne the criteria for a search, Outlook fi lters out all messages that don’t 
match, which makes it easy to fi nd exactly what you’re looking for. And   here’s the neat 
thing: Outlook searches not only the content of the e-mail message header and the 
message itself, but also the content of message attachments. So if the search term you’re 
looking for is in a Microsoft Word document attached to a message, the message is 
included in the search results.

Tip If   your organization uses Public Folders (a feature of Exchange) you can use these same 
tools to search a Public Folder, but the content isn’t fi ltered instantly; you must press Enter or 
click the Search button to get the same results as you would in a standard account folder.
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Using Search Folders

A    Search Folder displays all the messages in your mailbox that match a specifi c 
set of search criteria, no matter which folders the messages are actually stored in. 
When you create a Search Folder, it becomes part of your mailbox and is kept up to 
date. The Search Folder module is located in the Navigation Pane under your top-
level mailbox, at the same level as the Inbox.

Outlook 2010 doesn’t include any standard Search Folders. If you want quick access 
to messages that fi t a specifi c set of criteria, you can create a custom Search Folder. 
To do so, follow these steps:

 1. Display any mail folder.

 2. On the Folder tab, in the New group, click New Search Folder.

Keyboard Shortcut Press  Ctrl+Shift+P to create a Search Folder.

The  New Search Folder dialog box opens.

Search Folder categories include Reading Mail, Mail From People And Lists, Organizing 
Mail, and Custom.
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 3. In the New Search Folder dialog box, select the type of Search Folder you 
want to create, and then click OK.

You can choose from the standard options presented or click Create A 
Custom Search Folder to specify other search options.

You can make changes to the contents of an existing Search Folder by right-clicking 
the folder and then clicking Customize This Search Folder.

Outlook automatically keeps Search Folder contents up to date. The names of 
folders containing unread items are bold, followed by the number of unread 
items in parentheses. The names of folders containing items fl agged for follow up 
are bold, followed by the number of fl agged items in square brackets. The names 
of folders whose contents are not up to date are italic.  To update a Search Folder, 
click the folder name.

Each message in your mailbox is stored in only one folder (such as your Inbox), but 
it might appear in multiple Search Folders. Changing or deleting a message in a 
Search Folder changes or deletes the message in the folder in which it is stored.

In this exercise, you’ll use the Search feature to locate a specifi c message in your Inbox. 

SET UP Use the SBS First Draft, RE: SBS First Draft, FW: SBS First Draft, and SBS 
Tradeshow Schedule messages, and the SBS Messages folder, you worked with earlier 
in this chapter. If you didn’t create those practice fi les, you can do so at this time or 
substitute messages and a folder of your own. Display your Inbox and the Reading 
Pane, and then follow the steps.

 1. In  the Search box at the top of the message list, type the.

Keyboard Shortcut Press  F3 or Ctrl+E to move the cursor to the Search box.

As you type, the Search contextual tab appears on the ribbon, and options for 
refi ning your search appear below the Search box.

Selecting an option other than Keyword enters the alternative search criterion (and term) 
in the Search box.
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Outlook fi lters the messages in your Inbox to include only those that contain the 
word the, and highlights all occurrences of the word in the message list and in 
the active message.

Initial search results include only messages contained in the Inbox folder and not in any of 
its subfolders or any other mailbox folders.

In the lower-left corner of the program window, the status bar displays the number 
of messages included in the search results.

 2. On the Search tab, in the Refi ne group, click the    Subject button.

Outlook adds the subject criterion to the Search box and prompts you to enter 
keywords that should appear in the Subject fi eld of all search results.

You replace the placeholder with the words you want to fi nd in the subject fi eld.

 3. With keywords highlighted, type SBS.

Outlook instantly updates the search results to display only the messages in your 
Inbox that contain the word the and have SBS somewhere in the Subject fi eld. 

If you’ve followed along with all the exercises in this chapter, it’s likely that the current 
search returns no results.

 4. On the Search tab, in the Scope group, click the    All Subfolders button.
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Keyboard Shortcut Press  Ctrl+Alt+Z to expand a search to include subfolders. Press 
Ctrl+Alt+A to expand a search to include all items of the current type.

The SBS First Draft conversation and SBS Tradeshow Schedule message that you moved 
to the SBS Messages subfolder in previous exercises appear in the search results.

 5. In the message list header, click the Arrange By bar, and then click Folder.

The search results change to refl ect the new arrangement.

Grouping the results of a search that includes All Subfolders by folder can help you to 
locate messages.

 6. In the Options group, click the   Recent Searches button.

Your recent searches are saved so that you can use the same search again at 
another time. 

Clicking a previous set of search criteria reruns that search against your current items.

 7. Experiment with locating information by specifying criteria. When you fi nish, click 
the  Close Search button to remove the fi lter and redisplay the Inbox message list.

Keyboard Shortcut Press Esc to clear the search results.

CLEAN UP Retain the SBS Messages folder and its contents for use in later exercises.
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Printing Messages
Although   electronic communications certainly have less environmental impact than 
paper-based communications, you might from time to time want or need to print 
an e-mail message—for example, if you want to take a hard copy of it to a meeting 
for reference, or if you keep a physical fi le of important messages or complimentary 
feedback. You can print the message exactly as it appears in your Inbox or embellish 
it with page headers and footers. Outlook prints the message as shown on-screen, 
including font and paragraph formats.

In this exercise, you’ll preview a message as it will appear when printed, add a page 
header, and then print the message.

Important To fully complete this exercise, you must have a printer installed. If you don’t have 
a printer installed, you can perform all steps of the exercise other than printing.

To   install a printer, click   the Start button, click Devices And Printers, and then on the toolbar, 
click Add A Printer. Follow the wizard’s instructions to install a local or network printer. Your 
network administrator can provide the information you need to install a network printer.

SET UP You need the SBS Tradeshow Schedule message you worked with earlier 
in this chapter. If you did not create that message, you can do so now, or you can 
substitute any message in your Inbox. Open the SBS Tradeshow Schedule message, 
and then follow the steps.

 1. In   the message window, display the Backstage view, and then click Print.

The Print page of the Backstage view displays the current print settings.

The Print page of the Backstage view.
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The right pane displays the message as it will appear when printed, if you click the 
Print button without changing the settings shown in the center pane.  If necessary, 
you can adjust the following settings:

❍ Printer Select an installed printer or add a new one.

❍ Print Options Opens the  Print dialog box, where you can change the default 
printing options before printing. You can also change an existing print style (the 
way the message is presented on the printed page) or create a new one.

❍ Print Style Choose from the existing print styles available for the selected mes-
sage or other Outlook item. The default print style is Memo style, which prints 
your name, the message header information, and then the message content.

 2. Click the  Print Options button.

The  Print dialog box opens, displaying your default printer settings, which you can 
change before printing. Clicking OK prints the message with the current settings.

The Print dialog box displaying the basic Memo Style for printing a message.

 3. In the Print dialog box, click Page Setup.
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The    Page Setup: Memo Style dialog box opens. You can change the font, paper 
size, page margins, header, and footer from this dialog box.

 4. In the Page Setup: Memo Style dialog box, on the Format page, click the Font 
button.

The  Font dialog box opens.

 5. In the Font list, click Arial. In the Font style list, click Narrow Bold Italic. Then 
click OK.

 6. In the Page Setup: Memo Style dialog box, click OK, and then click Preview in 
the Print dialog box.

 7. In the lower-right corner of the Print page of the Backstage view, click the    Actual 
Size button to display the message at 100 percent of its size.

The right pane of the Print page displays the message as it will appear when printed, 
with the header text in Arial Narrow Bold Italic.

You can preview the message at its full size.

Tip If a message will be longer than one page when printed with the current settings, 
you can click the  Multiple Pages button to preview all pages of the message at the same 
time. You might fi nd this useful when, for example, you want to check page breaks or 
scan a document for a particular element.

 8. Click Print Options, click Page Setup, and then in the Page Setup: Memo Style 
dialog box, click the Paper tab to see the available options.

In   addition to choosing the paper size, you can select the number of pages that will 
be printed on each sheet of paper, and set the page margins and the orientation.
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The Paper page of the Page Setup dialog box.

 9. Click the Header/Footer tab.

 10. In  the Header area, type For Your Information in the center box, and then click the 
Font button above the box. In the Font dialog box, under Size, click 16, and then 
click OK.

The text you entered doesn’t refl ect the font size change, but the Header box to the 
left of the Font button indicates the current font selection.

 11. In the Footer section, select the default text (the page number) that appears in the 
center box. Then in the AutoText box that appears near the bottom of the Page 
Setup dialog box, click the User Name button.

Outlook will print the specifi ed text at the top of the page and your name (or user 
name, if different) at the bottom.

 12. In the Page Setup dialog box, click OK, and then in the Print dialog box, click Print.

Troubleshooting If the Save As dialog box opens, you do not have a printer installed.

Outlook prints the message, including your custom header and footer, to the active 
printer.

CLEAN UP If you don’t want to retain the custom header and footer as part of the 
standard message printing template, remove them from the Memo Style. Then close 
the SBS Tradeshow Schedule message.
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Deleting Messages
When   you delete a message, contact record, or any other item, Outlook temporarily moves 
it to the Deleted Items folder of your mailbox. You can open the folder from the Navigation 
Pane, view items that have been deleted but not purged, and restore items (undelete them) 
by moving them to other folders.

Keyboard Shortcut Press  Shift+Delete to permanently delete a message from a message list 
without fi rst moving it to the Deleted Items folder.

By default, Outlook does not permanently delete items until you purge them from the 
Deleted Items folder.  You can empty the entire Deleted Items folder manually or auto-
matically, or you can permanently delete individual items from it.

To permanently delete an individual item, follow these steps:

 1. In the Navigation Pane, click the Deleted Items folder to display its contents.

 2. In the Deleted Items list, click the item (or select multiple items) you want to 
delete.

 3. On the Home tab, in the Delete group, click the Delete button (or press the 
Delete key).

 4. In the Microsoft Outlook message box asking you to confi rm that you want to 
permanently delete the selected item(s), click Yes.

To  manually empty the Deleted Items folder, follow these steps:

● In the Navigation Pane, right-click the Deleted Items folder, and then click 
Empty Folder.

To automatically empty the Deleted Items folder each time you exit Outlook, follow 
these steps:

 1. Display the Backstage view, and then click Options.

 2. On the Advanced page of the Outlook Options dialog box under Outlook Start 
And Exit, select the Empty Deleted Items Folder When Exiting Outlook check 
box. Then click OK.
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Key Points
● You can fi lter and locate messages in your mailbox by using the Search feature.

● You can group and sort messages by sender, time, subject, size, category, or any 
other fi eld.

● You can assign color-coded categories to messages and then group and sort items 
by color category. You can use the default Outlook categories or tailor them to fi t 
your needs.

● You can record miscellaneous information in electronic notes. You can categorize, 
search, display, and sort notes, and send notes to other people.

● You can create folders to organize your mail, and move items to folders manually 
or automatically.

● You can print a message when you need a paper copy. You can select from several 
print styles and make modifi cations to the print styles to suit your needs.

● When you delete a message or other Outlook item, it moves to the Deleted Items 
folder and is not permanently deleted until you empty the folder.
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 11 11   Manage E-Mail   Manage E-Mail
  Settings  Settings

In this chapter, you will learn how to
✔ Work with new mail notifi cations.
✔ Create rules to process messages.
✔ Block unwanted messages.
✔ Secure your e-mail.

To more easily manage the information you receive through e-mail, you can specify 
how Microsoft Outlook 2010 alerts you to and processes incoming messages. You can 
also take advantage of the many security features built into Outlook 2010 to keep your 
outgoing communications secure and to protect your computer system from spam, 
viruses, Web beacons, and other modern electronic threats.

In this chapter, you’ll learn how to maintain your information in Outlook in a secure and 
organized fashion. First you’ll work with new mail notifi cations. You’ll process incoming 
messages by using rules, and set up the Junk E-mail Filter to manage unwanted messages. 
Finally, you’ll learn about ways of ensuring that your e-mail communications are secure.

Practice Files The exercises in this chapter use Outlook items you created in exercises in 
previous chapters. If an exercise requires an item that you don’t have, you can complete 
the exercise in which you create the item before beginning the exercise, or you can 
substitute a similar item of your own. A complete list of practice fi les is provided in 
“Using the Practice Files” at the beginning of this book.
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Working with New Mail Notifi cations
When new messages, meeting requests, or task assignments arrive in your Inbox, Outlook 
alerts you in several ways so that you can be aware of e-mail activity if you are using 
another application or if you’ve been away from your computer.

● A  New Mail Message icon appears in the notifi cation area at the right end of the 
Windows Taskbar.

● A   semi-transparent desktop alert appears on your screen for a few seconds, 
displaying the name of the sender, the subject, and the fi rst few words of the 
message (approximately 125 characters).

Desktop alert

New Mail Message icon

Outlook icon

From the desktop alert, you can open a message, mark it as read, fl ag it for action, 
respond to it, or delete it.

You can change the location, transparency, and length of time desktop alerts 
appear, or you can choose not to display them.

❍ You  can position the alert inside or outside of the Outlook program window. 
For example, if you usually work with the taskbar hidden, you might want to 
position the alert away from the taskbar to prevent you from accidentally 
displaying the taskbar each time you point to an alert.

❍ The alert can be a solid color or up to 80 percent transparent. The default is 
20 percent transparent. You might fi nd that transparent alerts are less likely 
to interfere with your view of the work you’re doing.

❍ The alert can stay on the screen for from 3 to 30 seconds. The default is 
7 seconds.

● If    Outlook is minimized or another application window is active, a chime sounds. 
You can change the sound or turn it off.

● The   mouse pointer briefl y changes shape, from an arrow to an e-mail message, 
and back. You can turn off this feature.

You can customize and turn off these notifi cations.
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In this exercise, you’ll customize your desktop alert settings and process messages by 
using desktop alerts as you receive them.

SET UP You don’t need any practice fi les to complete this exercise. Display your 
Outlook Inbox, and then follow the steps.

 1. Display the Backstage view, and then in the left pane, click Options.

The Outlook Options dialog box opens.

 2. In the left pane of the  Outlook Options dialog box, click Mail.

 3. Scroll down the Mail page of the Outlook Options dialog box to display the 
Message arrival section.

From this section, you can customize the ways in which Outlook alerts you to the 
arrival of a new message.

You  can stop desktop alerts from appearing by clearing the Display A Desktop Alert 
check box.

 4. In the Message arrival section, click Desktop Alert Settings.

The   Desktop Alert Settings dialog box opens.

You can set the duration and transparency for desktop alerts.
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Tip To  quickly access the Desktop Alert Settings dialog box, when a desktop alert 
appears, click the  Options button in the alert, and then click Desktop Alert Settings. 
You can turn off desktop alerts by clicking the Options button and then clicking 
Disable New Mail Desktop Alert.

 5. Drag  the Duration slider to the left end of the slider bar to set it to 3 seconds, 
and then click Preview.

A semi-transparent sample desktop alert appears in the lower-right corner of your 
desktop and fades away after three seconds.

You can preview the effects of changing the desktop alert settings.

 6. Click Preview again, and when the alert appears, point to it.

The semi-transparent alert becomes solid. As long as the mouse pointer is 
positioned over the alert, it remains visible.

 7. Drag   the sample desktop alert to the upper-right corner of your screen.

Future desktop alerts will appear wherever you move the sample alert.

 8. In the   Desktop Alert Settings dialog box, drag the Transparency slider to the 
left end of the slider bar to set it to 0% transparent, and then click Preview.

The sample desktop alert appears in the upper-right corner of the screen and its 
transparency lessens until it is opaque.

 9. Move the desktop alert to the position at which you want it to appear in the future. 
Then experiment with the options in the Desktop Alert Settings dialog box and set 
the duration and transparency as you want, previewing your changes as necessary.

 10. When you’re done, click OK in the Desktop Alert Settings dialog box, and click 
OK in the Outlook Options dialog box.

 11. On the Home tab, in the New group, click the  New E-mail button.

A new message window opens.

 12. Enter your e-mail address in the To box, and then in the Subject box, type SBS 
Alert Test 1.

Important The subject of each message we instruct you to send to yourself while 
working through the exercises in this book begins with SBS so that you can easily 
differentiate the practice fi les from other messages in your Inbox and Sent Items 
folders.
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 13. In the message body, type This is a test. Then send the message.

When   the message arrives in your Inbox, the New Mail Message icon appears in 
the notifi cation area at the right end of the taskbar, and a desktop alert appears 
on your screen.

 14. When the desktop alert appears, point to (but don’t click) its message text.

The message sender, subject, and text are underlined.

You can click the underlined text in the desktop alert to open the message in a message 
window.

 15. In the desktop alert, click the   Options button.

A menu of options appears. 

You can process an incoming message from a desktop alert without switching to Outlook.

 16. On the Options menu, click Mark as Read.

The   desktop alert closes, and in your Inbox, the message corresponding to the 
desktop alert is marked as read (whether or not the Inbox is visible).
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 17. On the Home tab, in the New group, click the  New Items button, and then in 
the list, click Meeting.

A new meeting window opens.

 18. Enter your e-mail address in the To box, enter SBS Alert Test 2 in the Subject 
box, and enter My Inbox in the Location box. Then send the meeting request. 
If a meeting reminder window opens, click Dismiss.

See Also For more information about meeting requests, see “Responding to Meeting 
Requests” in Chapter 5, “Manage Scheduling.”

 19. When the desktop alert appears, point to it, and then click the    Delete Item button.

The message corresponding to the desktop alert moves from your Inbox to the 
Deleted Items folder, and the desktop alert closes.

Tip If a meeting reminder window opens, click Dismiss.

CLEAN UP Retain the SBS Alert Test 1 message in your Inbox for use in later 
exercises.

Tip When  the Outlook icon is active in the notifi cation area of the status bar, you can click it 
to access commands for controlling the display of various types of alerts: Microsoft Exchange 
Server messages, network warnings, network connectivity changes, and new mail desktop alerts.

The Outlook icon is not shown by default. To display it, click the    Show Hidden Icons button 
at the left end of the notifi cation area, click Customize, and then in the Notifi cation Area Icons 
window of Control Panel, in the Microsoft Outlook list, click Show Icon And Notifi cations.

Creating Rules to Process Messages
You can have Outlook evaluate your incoming or outgoing e-mail messages and take 
various actions with them based on sets of instructions you set up, called rules. You can 
create rules based on different message criteria such as the message sender, message 
recipients, message content, attachments, and importance. By using rules, you can have 
Outlook automatically move, copy, delete, forward, redirect, reply to, or otherwise pro-
cess messages based on the criteria you specify. You can choose from a collection of 
standard rules or create your own from scratch.

If you   have an Exchange account, you can set up rules that are applied to messages as 
they are received or processed by your Exchange server, and you can set up rules that go 
into effect only when you indicate that you are unavailable, by setting up an Automatic 
Reply. Whether or not you have an Exchange account, you can set up rules that are 
applied to messages stored on your computer.

Tip You cannot use Outlook rules to fi lter messages sent to an Internet e-mail account.
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See Also For information about setting up Outlook to automatically respond to and process 
messages when you are unavailable, see “Automatically Replying to Messages” in Chapter 12, 
“Work Remotely.”

In this exercise, you’ll create a rule to process incoming messages that meet specifi c 
criteria.

SET UP You need the SBS Alert Test 1 message you created in the preceding exercise 
and the contents of the SBS Messages folder you created in Chapter 7, “Organize Your 
Inbox.” If you have not already created the message or created and populated the 
folder, you can you can do so now, or you can substitute any messages in your Inbox 
and adjust the rule criteria accordingly. Display your Outlook Inbox, and then follow 
the steps.

 1. On the Info page of the Backstage view, click the  Manage Rules & Alerts 
button.

The  Rules And Alerts dialog box opens, displaying the E-mail Rules page.

Your organization might have server-based rules that are not displayed in this dialog box.

 2. On  the E-mail Rules page, click New Rule.

The  Rules Wizard starts.
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The wizard leads you through the steps of creating a rule.

You can base a rule on one of the nine rule templates provided by Outlook, or you 
can start from a blank rule for incoming or outgoing messages.

 3. In   the Select a template box, click each of the rule templates in the Stay Organized 
and Stay Up to Date lists.

The criteria and actions associated with the selected rule appear in the Edit The 
Rule Description box.

Tip The name of the large box begins with Step 1. This text remains at the beginning 
of the name as the wizard leads you through a series of steps. We therefore refer to the 
box by the descriptive name that follows.

 4. In t he Start from a blank rule list, click Apply rule on messages I receive.

This basic information appears in the Step 2 box.
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 5. In the Rules Wizard, click Next.

The Step 1 box changes to display a list of conditions that you can apply to incoming 
messages. 

 6. In  the Select condition(s) box, scroll down the list to see the conditions you can 
apply. Then select the with specifi c word(s) in the subject check box.

Outlook adds the selected condition to the Edit The Rule Description box. You can 
specify as many conditions as you want.

Outlook will apply the fi nished rule to incoming messages that meet 
the conditions you select.

 7. In the Edit the rule description box, click the underlined term specifi c words.

The   Search Text dialog box opens.
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 8. In the Specify words or phrases to search for in the subject box, enter SBS. 
Then click Add.

The specifi ed term is enclosed in quotation marks and moves to the Search List box.

The rule will apply to messages with subjects that include any of the specifi ed search terms.

 9. In  the Search Text dialog box, click OK. Then in the Rules Wizard, click Next.

The Step 1 box changes to display a list of actions that can be performed on 
incoming messages. 

 10. Scroll  through the Select action(s) list to review the actions Outlook can perform 
on incoming items that meet the criteria you specify. Then select the move a copy 
to the specifi ed folder check box, and in the Edit the rule description box, click 
the underlined word specifi ed.

The  Rules And Alerts dialog box opens, displaying the folders in your mailbox.

You can choose an existing folder or create a new folder directly from the dialog box.
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 11. In   the Rules and Alerts dialog box, click the Expand button to the left of the 
Inbox, click the SBS Messages folder, and then click OK.

Troubleshooting If you didn’t create the SBS Messages folder in an earlier exercise, 
click Inbox in the Choose A Folder list, click New, enter SBS Messages as the folder 
name in the Create New Folder dialog box, and then click OK.

 12. In the Rules Wizard, click Next.

The   Step 1 box changes to display a list of exceptions you can specify that will cause 
Outlook not to apply the rule to messages that meet the selected conditions. 

Exceptions you specify on this page overrule the conditions specifi ed previously.
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 13. In   the Rules Wizard, without selecting an exception, click Next.

The fi nal page of the Rules Wizard summarizes the parameters of the SBS rule.

You can review the specifi ed criteria and actions.

 14. Select   the Run this rule now… check box, and then click Finish.

Outlook runs the rule on the contents of your Inbox and then saves the rule in the 
Rules And Alerts dialog box.

All the rules you’ve created appear in this list, whether or not they’re turned on.
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The selected check box to the left of the rule name indicates that this rule is active 
and that Outlook will apply it to all incoming messages.

 15. In the Rules and Alerts dialog box, click OK.

 16. Click the Home tab. In the Navigation Pane, expand the Inbox if necessary, and 
then click the SBS Messages folder.

The folder contains practice messages you created in earlier chapters of this 
book, as well as the SBS Alert Test 1 message you created in the preceding 
exercise.

 
The SBS Alert Test 1 message has been moved from your Inbox to the specifi ed folder.

Troubleshooting The appearance of buttons and groups on the ribbon changes 
depending on the width of the program window or item window. For information 
about changing the appearance of the ribbon to match our screen images, see 
“Modifying the Display of the Ribbon” at the beginning of this book.

CLEAN UP Retain the SBS Messages folder and its contents for use in later 
exercises.
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Blocking Unwanted Messages
Outlook  offers levels of protection for managing junk e-mail messages (also called spam)—
the unsolicited advertisements, sometimes containing dangerous attachments, that can 
swamp your Inbox if your e-mail address fi nds its way into the hands of unscrupulous 
mailing list vendors. When enabled, the Junk E-Mail Filter either moves messages that 
appear to be junk e-mail to a special folder or deletes them.  You can specify a list of 
e-mail addresses or domains whose messages should always be treated as junk; you 
can also specify a list of e-mail addresses or domains from whom messages should 
never be treated as junk.

Outlook  also offers protection from phishing—a widespread identity theft scam. 
Phishing messages are e-mail messages that contain links to phishing sites purporting 
to represent trusted, known entities, such as banks or e-commerce sites that would 
likely have your personal information on fi le. The messages request that you update 
your personal information through the link provided. If you do so, you inadvertently 
provide the requested information (which might include your social security number, 
bank account number, passwords, and other confi dential information) to scam artists, 
who might then sell or otherwise use the information for their own fi nancial gain. In the 
past, you were in danger only if you submitted your information through the phishing 
site, but these sites are becoming increasingly sophisticated, and many now host 
malicious keystroke-logging software. You can infect your computer just by visiting 
such sites, which makes it vital that you protect yourself from these threats.

See Also Windows Internet Explorer 8 provides built-in protection against phishing sites. 
For more information, refer to Windows 7 Step by Step, by Joan Lambert Preppernau and 
Joyce Cox (Microsoft Press, 2009).

Working with Junk E-Mail Messages
By    default, when Outlook receives a message that it deems to be either junk mail or a 
phishing message, it delivers that message to the Junk E-Mail folder associated with your 
account rather than to your Inbox. (Each account you confi gure Outlook to connect to 
has its own Junk E-Mail folder.) You might not be aware that one or more messages has 
been redirected to your Junk E-mail folder; if someone tells you that he or she has sent 
you a message but you haven’t received it, it’s good idea to check whether it’s in your 
Junk E-Mail folder.
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You   can display the contents of the Junk E-mail folder by clicking Junk E-Mail in the folder 
list of your account, in the Navigation Pane. When the Junk E-Mail folder contains one 
or more messages, the folder name is bold, and the number of messages in the folder is 
shown in parentheses at the end of the folder name. This is similar to the way that your 
Inbox folder name appears when the Inbox contains unread messages, but in this case, 
the bold formatting is not linked to the read status of the message.

Bold formatting indicates that the Junk E-Mail folder contains one or more messages.

When      you open a message from the Junk E-Mail folder, Outlook converts the message 
content to plain text and disables any active links or content within the message. The 
information bar in the message header provides specifi c information about the message’s 
status. Suspected junk e-mail messages have orange information bars; suspected phishing 
messages have pink information bars.
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Outlook disables functionality in a message that it suspects to be spam.

Any remote graphics (graphics that are displayed from Internet locations rather than 
embedded in the message—sometimes called Web beacons) that were present in the 
message are converted to URLs so you can easily see where the graphics originated.

See Also For more information about Web beacons, see “Blocking External Content to 
Protect Your Privacy” later in this chapter.

Although   the response options on the ribbon are active, you can’t reply to a message from 
the Junk E-Mail folder—you must fi rst move it to the Inbox or another folder.   You can 
forward a message from the Junk E-Mail folder; you might want to forward a message 
to someone else who can verify for you whether the message is valid. The forwarded 
message will be in plain-text format rather than the original message format.

You    can delete messages from the Junk E-Mail folder or indicate to Outlook how you 
would like the Junk E-mail fi lter to handle similar messages in the future.

To process a message from the Mail pane of the Junk E-Mail folder:

 1. In the Mail pane, select the message you want to process.

 2. On the Home tab, in the Delete group, click the    Junk button.

The Junk list displays your options for processing the message.
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You can confi gure Outlook to block or allow specifi c senders.

 3. Click    one of the fi rst four options to block the sender or to add the sender, the sender’s 
domain, or the recipient group to your Safe Senders or Safe Recipients list.

Clicking an option does not remove the message from the Junk E-Mail folder.

 4. To  move the message to your Inbox, click Not Junk. 

The Mark As Not Junk message box opens.

The dialog box might look different, depending on your Outlook e-mail account confi guration.

 5. If you do not want to move the message to the Inbox, click the Close button. 
Otherwise, select one or both of the Always Trust check boxes, and then click OK.

❍ Selecting  the Always Trust E-mail From check box adds the message sender 
to your Safe Senders list. 

❍ Selecting  a check box in the Always Trust E-mail Sent To The Following 
Addresses box adds that message recipient to your Safe Recipients list.
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To process an open message, click the  Junk button in the Delete group on the Message 
tab of the message reading window, and then click the option you want.

Confi guring Junk E-Mail Options
You   manage junk mail settings from the Junk E-mail Options dialog box, which you open 
by clicking Junk E-mail Options in the Junk list. You set specifi c junk e-mail processing 
options for each account to which Outlook is confi gured to connect. The account for 
which you’re confi guring options is shown in the title bar of the Junk E-mail Options 
dialog box.

The  Junk E-mail Options dialog box has fi ve pages.

● On  the Options page, you select a level of protection. If you don’t have additional 
fi lters in place, such as those that might be supplied by your organization, you 
might prefer to click High. Otherwise, click Low.

The Options page of the Junk E-Mail Options dialog box.
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If   you want Outlook to automatically delete suspected junk e-mail, select the 
Permanently Delete Suspected Junk E-Mail Instead Of Moving It To The Junk 
E-Mail Folder check box. Do not select this check box if you set the protection 
level to High or to Safe Lists Only. With these settings, it is likely that the Junk 
E-Mail Filter will catch quite a few valid messages that you don’t want deleted.

Note  that the Disable Links And Other Functionality In Phishing Messages check 
box is selected by default. Unless you are very confi dent that you have another 
protective system in place, leave this option selected.

● On   the Safe Senders page, you can add a specifi c person’s e-mail address to the 
Safe Senders list (for example, tom@contoso.com) or specify that e-mail received 
from any sender at a particular domain is safe by adding only the domain (for 
example, @contoso.com).

The Safe Senders page of the Junk E-Mail Options dialog box.

To ensure that messages from your legitimate contacts aren’t moved to the Junk 
E-mail folder by the Junk E-Mail Filter, select the Also Trust E-mail From My Contacts 
and Automatically Add People I E-mail To The Safe Senders List check boxes.
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● On   the Safe Recipients page, you can add distribution lists or mailing lists of 
which you are a member to your Safe Recipients List to ensure that messages 
sent to you through the distribution list or mailing list will never be treated as 
junk e-mail.

The Safe Recipients page of the Junk E-Mail Options dialog box.

● On    the Blocked Senders page, you can manually add e-mail addresses and 
domain names to the Blocked Senders list, or Outlook will add them for you 
whenever you identify a received message as junk e-mail.

The Blocked Senders page of the Junk E-Mail Options dialog box.

Tip To   add the sender or recipient of a message to one of your Junk E-Mail lists, 
right-click the message in your Inbox or other mail folder, click Junk, and then click 
Block Sender, Never Block Sender, Never Block Sender’s Domain, or Not Junk.
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● On     the International page, you have the option of blocking all messages from a 
country-specifi c, top-level domain, or all messages containing spec ifi c non-English 
text encoding.

The International page of the Junk E-Mail Options dialog box.

Click   Blocked Top-Level Domain List to access the list of top-level domains you can 
block. Click Blocked Encodings List to access the list of languages you can block. 

You can block entire country-specifi c and language-specifi c groups of messages.
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Securing Your E-Mail
As your e-mail messages travel from server to server en route to you or other message 
recipients, they are vulnerable to interception by hackers and others who are intent on 
viewing them. With Outlook 2010, you can safeguard your messages in several ways, 
including implementing digital signatures, encryption, plain text messages, and Informa-
tion Rights Management (IRM). In certain corporate environments, particularly those 
that handle sensitive data such as legal and accounting fi rms, specifi c e-mail security 
procedures might be mandated and enforced. In the absence of such guidance, only 
you can decide whether any of these additional security measures are appropriate 
for your situation. 

Digital Signatures
When  sending messages, you can reassure message recipients that they are receiving 
valid messages from you by using a digital signature—a piece of code that validates 
the identity of a message sender (not the actual person, but the e-mail account and 
computer from which the message originates).

Obtaining a Digital ID
To  send digitally signed or encrypted messages over the Internet, you must obtain a digital 
ID from an independent certifi cation authority. The fi rst time you try to digitally sign or 
encrypt a message without having a valid digital ID installed on your computer, Outlook 
prompts you to obtain one. If you prefer, you can obtain one before you need it.

Obtaining some types of digital IDs, such as those used to certify the source of software 
programs, involves a stringent application process that can take weeks to complete. 
However, applying for a digital ID to certify documents and e-mail messages is a rela-
tively simple process.  You can have more than one digital ID on your computer, and 
you can select which one to use for each document or message. For example, you 
might have one digital ID for business use and one for personal use.

If  you have an Exchange account, your Exchange administrator may be able to issue you 
a digital ID. Otherwise, you’ll need to get one independently. Many U.S. and international 
certifi cation companies offer digital IDs to certify e-mail. You’ll probably be most comfort-
able purchasing a certifi cate in your native currency. Regardless of where you obtain it, 
your digital ID is valid worldwide.
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To  obtain a digital ID to sign or encrypt documents and messages:

 1. On the  Trust Center page of the Outlook Options dialog box, click Trust Center 
Settings.

The Trust Center dialog box opens.

 2. In  the left pane, click E-mail Security.

From this page you can confi gure many of the settings we discuss in this topic.

The Publish To GAL (Global Address List) button is available only in a centrally administered 
Exchange environment.

 3. In the Digital IDs (Certifi cates) area of the E-mail Security page, click Get A 
Digital ID.

The  Microsoft Offi ce Online Web site opens in your default Web browser, listing 
providers from whom you can obtain a digital ID to certify documents and e-mail 
messages.
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Tip If   you want to use a certifi cation authority other than one of those recommended by 
Microsoft, search the Web for digital ID or certifi cation authority, and you’ll fi nd a number 
of options. You can apply for a digital ID from any certifi cation authority through its Web 
site. Digital IDs from non-recommended providers might have compatibility issues with 
Windows Internet Explorer, so if you use Internet Explorer and you want to be certain you 
won’t run into problems, use one of the recommended providers.

 4. Click the link at the end of a provider’s description to display the provider’s Web site.

 5. Follow  the instructions on the Web site to register for a digital ID.

Some certifying authorities charge a small fee, but most offer free digital IDs or a 
free trial period. As part of the process, you’ll likely be required to respond to an 
e-mail message from your computer.

Your  digital ID will be installed on the computer on which you complete the application 
process, but it is associated with your e-mail address; if you need to use it on another 
computer, you can reinstall it from the provider’s site, or you can export the digital ID 
fi les from the original computer and import them on the other computer.

To export or import a digital ID:

 1. Display    the E-mail Security page of the Trust Center dialog box.

 2. In the Digital IDs (Certifi cates) area of the E-mail Security page, click Import/Export.

The  Import/Export Digital ID dialog box opens.

You can import and use any digital ID that is associated with your e-mail address.
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 3. In the Import/Export Digital ID dialog box, select whether you want to import or 
export your digital ID, provide the appropriate information, and then click OK.

Tip You can also import a digital ID from the Certifi cates page of a contact record window. 
For information, see “Working in the Contacts Module” in Chapter 2, “Explore the Outlook 
Windows.”

Digitally Signing Messages
You  can digitally sign individual messages when you compose them, or you can instruct 
Outlook to digitally sign all outgoing messages.

The   fi rst time you digitally sign a message, you need to confi gure your security settings 
to use your digital certifi cate. You must do this from the  Trust Center dialog box.

Troubleshooting You can follow a similar process to confi gure security settings from 
the message window, but there appears to be a bug in the system that results in this not 
working—so be sure to follow the Trust Center process.

To   confi gure digital certifi cate settings, follow these steps:

 1. Display the E-mail Security page of the Trust Center dialog box.

 2. To the right of the Default Setting box, click Settings.

The  Change Security Settings dialog box opens.

You need to specify digital signing and encryption certifi cates.
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 3. In the Change Security Settings dialog box, to the right of the Signing Certifi cate 
box, click Choose.

The  Windows Security dialog box opens.

The dialog box displays the digital signing certifi cates available on your computer.

 4. In   the Windows Security dialog box, click the digital certifi cate you want to use 
to digitally sign outgoing messages, and then click OK.

The selected certifi cate information appears in the  Change Security Settings 
dialog box.

By default, Outlook also assigns the selected certifi cate for message encryption.
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 5. In the Security Settings Name box, enter a name by which you’ll identify the 
signing certifi cate. Then click OK in the Change Security Settings dialog box, in 
the Trust Center dialog box, and in the Outlook Options dialog box.

After you complete this process, the   Digital Signature and Encryption buttons appear 
in the Permission group on the Options tab of the message composition window.

By default, Outlook also assigns the selected certifi cate for message encryption.

To   digitally sign an individual e-mail message:

● On the Options tab, in the Permission group, click the  Digitally Sign Message 
button.

A message   with a valid digital signature has a red ribbon on its message icon and a digital 
signature icon (also a red ribbon) in its message header. When you receive a digitally signed 
message, you can click the digital signature icon to view information about the signature.

To digitally sign all outgoing messages:

 1. Display the E-mail Security page of the  Trust Center dialog box.

 2. In the Encrypted E-mail area of the E-mail Security page, select the Add Digital 
Signature To Outgoing Messages check box.

 3. If all your message recipients don’t have Secure Multipurpose Internet Mail Extensions 
(S/MIME) security (for instance, if you’re sending messages to people who you know 
aren’t using Outlook), ensure that the Send Clear Text Signed Message When Sending 
Signed Messages check box is selected (this is the default setting).
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Encryption
You  can secure the contents of outgoing messages by using encryption. Encryption ensures 
that only the intended recipients can read the messages you send. The message recipient’s 
e-mail program must have corresponding decryption capabilities in order to read the 
message.

You can encrypt individual messages when you compose them, or you can instruct 
Outlook to encrypt all outgoing messages.

To  encrypt an individual message:

● On the Options tab, in the Permission group, click the   Encrypt button.

Troubleshooting If you haven't previously used the Encryption feature in Outlook 2010, 
the Encrypt Message Contents And Attachments button might not be visible. If this 
is the case, click the More Options dialog box launcher on the Options tab, and then in 
the Properties dialog box, click Security Settings. In the Security Properties dialog box, 
select the Encrypt Message Contents And Attachments check box, and click OK. Then 
close the Properties dialog box.

To   encrypt all outgoing messages:

 1. Display the E-mail Security page of the Trust Center dialog box.

 2. In the Encrypted E-mail area of the E-mail Security page, select the Encrypt 
Contents And Attachments For Outgoing Messages check box.

 3. To   receive verifi cation that a message recipient received an encrypted message in 
its encrypted format, select the Request S/MIME Receipt For All S/MIME Signed 
Messages check box.

An encrypted message has a    blue lock on its message icon and an encryption icon (also 
a blue lock) in its message header. When you receive an encrypted message, you can 
click the encryption icon to view the message security settings.

Tip If you try to send an encrypted message from Outlook to a recipient whose e-mail 
confi guration doesn’t support encryption, Outlook notifi es you and gives you the option 
of resending the message in an unencrypted format.
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Plain Text Messages
These  days, viruses and other harmful programs can easily be spread from computer 
to computer through active content embedded in or linked to from e-mail messages. To 
ensure that the e-mail messages you receive won’t harm your computer, you might want 
to display them in plain text, rather than in Rich Text Format or HTML. Links, scripts, and 
other active content are disabled in plain text messages.

To  receive all messages in plain text format:

 1. Display the E-mail Security page of the  Trust Center dialog box.

 2. In the Read As Plain Text area of the E-mail Security page, select the Read All 
Standard Mail In Plain Text check box, and then click OK.

Information Rights Management
If      you don’t want a message recipient to forward, copy, or print your message, you can 
send it with restricted permissions. You use Information Rights Management (IRM) to 
set these permissions, which control who can read your messages and what they can do 
with them. If the restricted message includes an attachment, such as a Microsoft Word 
document, an Excel workbook, or a PowerPoint presentation, the recipient can’t edit, 
copy, or print the attachment (unless you have set individual permissions to allow those 
actions within the document).

To use IRM, you need access to an IRM server. If your organization has its own IRM 
server, your administrator can advise you how to set restricted permissions. If you 
don’t have access to an IRM server, Outlook prompts you to sign up for a free trial 
on an IRM server provided by Microsoft the fi rst time you try to set permissions for 
a message. 
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You can use the Microsoft IRM service if your organization doesn’t have an internal IRM server.

To take advantage of this free trial, you click Yes in the  Service Sign-Up dialog box and 
then sign up for a  Rights Management (RM) account certifi cate for your outgoing e-mail 
address (which must be registered as a Windows Live ID). The certifi cate is valid for six 
months. After fi nishing the sign-up process, you can restrict permissions for outgoing 
messages sent from the computer on which the certifi cate is installed.

Tip Registering your e-mail address as a Windows Live ID provides you with the credentials 
necessary to sign in to many sites and services provided by Microsoft and other companies. 
To register your e-mail address as a Windows Live ID, visit home.live.com.

To prevent message recipients from forwarding, printing, or copying a message:

● On      the Options tab, in the Permission group, click the Permission arrow, and then 
in the list, click Do Not Forward.

The information bar in the message header of the outgoing and received messages 
indicates what recipients can and can’t do with the message.
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You can restrict the ways in which message recipients can share message content with other people.

To read a message sent with restricted permissions, recipients must have Outlook 2010, 
Outlook 2007, or Outlook 2003.

Blocking External Content to Protect Your Privacy
E-mail     is increasingly used to deliver marketing information to customers and potential 
customers. Many companies include pictures in their marketing messages to help explain 
their product or to make the message more attractive and noticeable, but these pictures 
can make e-mail messages large. To avoid this problem, some companies include links 
to pictures that are hosted on their server. When you preview or open the message, you 
can see the pictures, but they aren’t actually part of the message.

Some junk mail senders are using this technology to include Web beacons in their mes-
sages. Web beacons are small programs that notify the sender when you read or preview 
the e-mail message. The notifi cation confi rms that your e-mail address is valid, and as a 
result, you might receive more junk e-mail.

To help protect your privacy, Outlook includes features that block external content such as 
pictures, sounds, and Web beacons. In addition to helping ensure your privacy, this blocking 
technique can save bandwidth resources, because you choose whether to download images 
and sounds, rather than downloading them automatically when you open a message.

By default, Outlook 2010 blocks external content to and from all sources except those 
defi ned in the Safe Senders list and Safe Recipients list. When you open or preview a 
message that contains blocked content, an information bar in the message header 
provides options for handling the blocked content.
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To  view the blocked content in an individual e-mail message:

● In the message header, click the information bar, and then click Download 
Pictures.

To change the way Outlook handles external content:

 1. Display the Automatic Download page of the Trust Center dialog box.

 2. Select the check boxes for the options you want, which include:

❍ Don’t download pictures automatically in HTML e-mail messages or 
RSS items.

❍ Permit downloads in messages from senders and to recipients defi ned in 
the Safe Senders and Safe Recipients Lists used by the Junk E-mail fi lter.

❍ Permit downloads from Web sites in this security zone: Trusted Zone.

❍ Permit downloads in RSS items.

❍ Permit downloads in SharePoint Discussion Boards.

❍ Warn before downloading content when editing, forwarding, or replying 
to e-mail.

 3. Click OK to save your settings.

Under most circumstances, the security provided by the default settings far outweighs 
the slight inconvenience of manually downloading content you want to see or hear. You 
will probably fi nd that many of the messages with blocked pictures are not of interest to 
you anyway, because they are generally marketing messages.
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Key Points
● Outlook alerts you to new messages in several ways, all of which are customizable.

● You can set up rules so that Outlook can evaluate and process messages depending 
on the criteria you set.

● You can digitally sign your messages, encrypt them, and set permissions for them. 
You can also display messages in plain text to disable any active content.

● Built-in fi lters block annoying or hazardous messages that conform to typical spam 
patterns or that contain active content.
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Clear Formatting button  50
client rules

client rulesdefi ned  503
Clip Art. See  also pictures

Clip Artdownloading  364, 365
Clip Artinserting  364, 366
Clip Artin signatures  354
Clip Artoverview of  364
Clip ArtScreenTips for, displaying  365
Clip Artsearching for  364

Clip Art button  364
Clip Art task pane  364
Clipboard

Clipboardclippings, removing  46
Clipboardclosing  46
Clipboardcopying text to  49
Clipboarddisplay, controlling  46
Clipboardopening  45
Clipboardoverview of  46
Clipboardpasting text from  46
Clipboardshared Offi ce access to  355

clippings. See  screen clippings
clock

clocktime zone, changing  279
cloning contact records  129, 137
Close button  xxvi, 25, 46
Close button (SmartArt)  385
Close Search button  243, 267, 335
closing Outlook  25
collapsing folders  459
collapsing groups  242
Color button  49
color categories  390. See  also categories

color categoriesadding new  249
color categoriesassigning  249
color categoriesassigning colors to  245, 248
color categoriesdeleting  249
color categoriesdisplay of  250
color categorieskeyboard shortcuts for  245, 249
color categoriesoverview of  244
color categoriesQuick Click category  246
color categoriesrenaming  245, 248

color categories dialog box  248
Color dialog box  342
color, font

color, fontchanging  49
color scheme

color schemecustomizing  483
column width in views  149
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commands
commandsadding to Quick Access Toolbar  475, 

478
commandsadding to ribbon  468, 471
commandslegacy  33, 468

commas for separating multiple recipients  489
commas, separating e-mail addresses with  85
Compact view (Inbox)  103
completing tasks. See  marking tasks as complete
composing e-mail messages  38

composing e-mail messagesdefault options, 
setting  484

composing e-mail messagesto multiple recipients, 
comma-separated  489

Confi dential sensitivity  389
Confi gure Buttons button  459
contact cards

contact cardsdefi ned  503
contact cardsexpanding  115
contact cardsoverview of  114

contact groups  326
contact groupsadding members to  326, 327, 328, 

330
contact groupscreating  89, 327, 330
contact groupsdsiplaying names in  332
contact groupsexpanding list  331
contact groupsmodifying  326, 332
contact groupsremoving members from  332
contact groupssending messages to  326

contact records
contact recordsactivities, displaying  68
contact recordsaddresses, entering  140
contact recordsaddresses, specifying default  135
contact recordsaddressing e-mail messages from  

141
contact recordsas attachments  105
contact recordsbirthdays, adding  137
contact recordsbusiness cards for. See  business 

cards
contact recordscertifi cates, displaying  69
contact recordscloning  129, 137
contact recordscopying  312
contact recordscreating  67, 133
contact recordscreating, from message senders  

139
contact recordsdefi ned  503
contact recordsdetails, displaying  68, 136
contact recordsDisplay As fi eld  133
contact recordsdisplaying  312
contact recordse-mail addresses, entering  134
contact recordsexporting  321, 322, 323
contact recordsfi elds, displaying all  69
contact recordsfi ling order  129
contact recordsfi lling in  133
contact recordsfi ltering  69, 145, 322, 334
contact recordsfollow-up fl ags, assigning  136

contact recordsformatting text in  65
contact recordsimporting  314, 316, 317
contact recordsimporting into separate address 

book  314
contact recordsinserting items in  65
contact recordskeyboard shortcut for creating  67
contact recordslinking items to  136
contact recordsmailing address, specifying  135
contact recordsmeeting requests, creating from  

141
contact recordsmoving  312, 313
contact recordsnotes in  71
contact recordsopening  339
contact recordsoptions, setting  494
contact recordsoverview of  128
contact recordsphone numbers, entering  132
contact recordspictures, adding  340
contact recordsprinting  151, 152
contact recordsprinting selected  159
contact recordsreordering  129
contact recordssaving  136
contact recordssearching  145
contact recordssearching for  307, 308, 333, 334, 

335, 336
contact recordsselecting  312, 313
contact recordssorting  147
contact recordsspouse/partner, adding  136
contact recordstypes of information in  128
contact recordsviews, customizing  148
contact recordsviews for  144
contact recordsviews, selecting  144, 145
contact recordszooming in/out  146

contact record windows  62
contact record windowsappearance of  63
contact record windowsBusiness Card view, 

switching to  66
contact record windowsdefi ned  503
contact record windowsopening  339

contacts
contactsaccessing offl ine  439
contactsadding to address book  148
contactsadding to contact group  327, 328, 330
contactsaddresses, mapping  141
contactsaddressing e-mail messages to  142
contactsautomatically adding  130
contactscreating  89
contactsdefi ned  63, 503
contactsdisplaying all communications with  117
contactsforwarding, as business cards  345
contactsgrouping. See  also contact groups
contactslisting  143
contactsmanaging  64
contactsmessage recipients, adding as  142
contactsscrolling to  142
contactstasks, creating from  202
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Contacts address book  130
Contacts button  66, 312
Contacts folder

Contacts foldercaching  435
contacts folders  308

contacts folderscreating  309
contacts folderssharing  308

contacts list, SharePoint
contacts list, SharePointconnecting to Outlook  

452
Contacts module. See  also address books

Contacts moduleappearance of  66
Contacts moduleCurrent View gallery  144
Contacts moduledefault display  61
Contacts moduledefi ned  503
Contacts moduledisplaying  27, 61, 66
Contacts modulekeyboard shortcut for displaying  

66
Contacts moduleopening  312
Contacts moduleoptions for  72
Contacts moduleribbon in  61
Contacts moduleviews for  61

Contacts pane  66
Contacts panedefi ned  503
Contacts paneinternational alphabet bar, adding  

67
Contacts panejumping to alphabet letter  67

content pane  36
content panedisplay, customizing  37

Content pane  26
contextual tabs  93
conversations

conversationsclassic indented view  235
conversationscleaning up  237
conversationsdefi ned  503
conversationsdeleting  236
conversationsdisplaying all messages in  234
conversationsexpanding  233
conversationsignoring  236
conversationslevels, displaying  233
conversationsmoving into folders  257
conversationsredundant messages, deleting  237
conversationsselecting all messages in  236
conversationssplit  233
conversationsvisual threads  233

Conversation view  111
Conversation viewclassic indented view  235
Conversation viewdefault settings  234
Conversation viewfor message management  235
Conversation viewheader in  232
Conversation viewoverview of  232
Conversation viewsenders, displaying above 

subjects  235
Conversation viewturning off  236

Copy button  49
copying calendar items  282

copying contact records  312
copying messages

copying messagespreventing  391
copying Offi ce content between programs  355
copying text  49

copying textdefault settings for  485
countries, blocking messages from  415
courtesy copies. See  Cc fi eld
Create New Folder dialog box  255, 309, 432
Create Outlook Data File dialog box  323
creating e-mail messages. See  composing e-mail 

messages
creating Quick Steps  462, 463, 464, 465
Crop arrow  376
Crop button  377
cropping pictures  377
custom calendars  281
Custom DPI Setting dialog box  xvii
Customize Quick Access Toolbar button  475, 477, 

480
customizing forms  500
customizing program settings  482
customizing program window  458
customizing Quick Access Toolbar  475, 476
customizing Reading Pane  459
customizing ribbon  467, 468, 469

customizing ribbonresetting to original 
confi guration  474

customizing status bar  481
customizing To-Do Bar  459
Cut button  46
cutting text  46

D
Daily Task List

Daily Task Listminimizing  191
Daily Task List button  191
data charts. See  charts
data encryption  13
data fi le

data fi leofl ine use, disabling  14
data fi lereducing size of  14

Date Navigator
Date Navigatorcomponents of  187
Date Navigatordefi ned  503
Date Navigatordisplay, modifying  460
Date Navigatorexpanding  188
Date Navigatormonth display in  188
Date Navigatornavigating in  165, 187, 195
Date Navigatoroverview of  187

Day view (Calendar)  185
Decline button  217
declined tasks, processing  215
declining meeting requests  182

526  Contacts address book
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declining tasks  217
Delegate Permissions dialog box  291
Delegates dialog box  291
delegating calendars  288, 290, 291, 292
delegating tasks. See  assigning tasks
Deleted Items folder  34, 272
Delete Item button  400
deleting

deletingQuick Step actions  465
deleting e-mail messages  272

deleting e-mail messagesfrom desktop alerts  400
deleting fl agged items from task lists  214
deleting junk e-mail messages  410

deleting junk e-mail messagesautomatically  413
deleting signatures from messages  355
delimited text fi les. See  separated text fi les
delivery options  390
demoting list items  93
desktop alerts  396

desktop alertsappearance of  399
desktop alertsdefi ned  503
desktop alertsdeleting items from  400
desktop alertsduration, changing  398
desktop alertsmoving position of  398
desktop alertsoptions, changing  399
desktop alertssettings, modifying  396, 397
desktop alertstransparency, setting  398
desktop alertsturning off  397, 398

Desktop Alert Settings dialog box  397, 398
Details button  77, 136
diagrams

diagramsinserting  383
diagramslayout, changing  386

dialog boxes
dialog boxesAccount Settings  15
dialog boxesMicrosoft Exchange  11
dialog boxesMicrosoft Exchange account settings  

12
dialog boxesOutlook Data File Settings  14
dialog boxesOutlook Options  32
help with  xxiii

dialog box launcher  32, 45
dialog box launcherdefi ned  503

dial-up connections
dial-up connectionsconnecting to Exchange 

accounts with  14
digital certifi cates

digital certifi catesconfi guring  419, 420
digital certifi catesinstalling  17
digital certifi catesverifying  17

digital IDs
digital IDscertifi cation authorities, searching  418
digital IDsimporting/exporting  418
digital IDsobtaining  416, 417, 418
digital IDsproviders, viewing  417

digital IDsusing on different computer  418
digital IDsvalidity of  416

Digital Signature button  421
digital signatures  389

digital signaturesapplying  419
digital signaturesattaching to messages  421
digital signaturescertifi cate confi guration  419, 420
digital signaturesdefi ned  504
digital signaturesicon for  421
digital signaturesoverview of  416

directory paths. See  paths
disabling desktop alerts  398
disconnecting Outlook from Internet  36
Display As fi eld in contact records  133
display settings different from book  xviii
distribution lists. See  contact groups; See  also 

contact groups
distribution listsdefi ned  504
distribution listsvs. contact groups  326

document libraries, SharePoint
document libraries, SharePointconnecting to 

Outlook  448, 449
document libraries, SharePointpreviewing items 

from  451
document libraries, SharePointsubfolders  451
document libraries, SharePointworking offl ine  451

document workspaces
document workspacesdefi ned  504

domains
domainsdefi ned  504

domains, blocking messages from  415
downloading cached items  436

downloading cached itemssettings for  437
downloading Clip Art  364, 365
downloading offl ine address books, turning off  

440
Download Preferences button  437
dpi settings  xvii
drafts

draftsautomatically saving  484
draftsautomatic deletion of  89
draftsdefault location, changing  488
draftsdefi ned  504
draftsoptions for saving  488
draftsresuming  89, 91
draftssave location, changing  89
draftssaving  88, 89
draftsviewing  90

Drafts folder  35, 89
Drafts folderviewing  90

drop shadow
drop shadowapplying  48, 49
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E
Edit Business Card dialog box  341
editing business cards  341, 342, 343
editing meetings  181
Editor Options dialog box  484

Editor Options dialog boxAdvanced page  485
Edit Quick Step dialog box  259, 462
Edit Rule dialog box  446
effects. See  text effects
electronic business cards. See  business cards
e-mail

e-maildefi ned  504
e-mail accounts. See  also Exchange accounts

e-mail accountsadding to Outlook  7
e-mail accountscalendars, displaying from  281
e-mail accountsconfi guring manually  18
e-mail accountsdifferent signatures for  354, 361
e-mail accountsExchange  4
e-mail accountsHotmail. See  Hotmail accounts
e-mail accountsmanually confi guring  10
e-mail accountsmultiple, confi guring  98
e-mail accountsPOP. See  POP accounts
e-mail accountsrenaming  12
e-mail accountssend/receive options, activating  

440
e-mail accountstesting settings  21

e-mail addresses
e-mail addressesaddress book search order, 

customizing  86
e-mail addressesfor contacts, entering  134
e-mail addressesinserting in address boxes  83
e-mail addressesseparating with commas  85
e-mail addressesvalidating  83

e-mail attachments. See  attachments
E-mail button  331
E-mail Calendar button  293
e-mail conversations. See  conversations
e-mail etiquette  119
e-mail formats

e-mail formatsHTTP  504
e-mail headers. See  headers, e-mail

e-mail headersdefi ned  505
e-mailing calendars  292, 293
e-mail messages. See  also drafts; sent messages; 

See  also message lists
e-mail messagesaddressing  89
e-mail messagesaddressing to contacts  142
e-mail messagesarranging  237, 239, 241
e-mail messagesautomatic fi ltering. See  rules
e-mail messagesBcc fi eld  83, 142
e-mail messagesbody of  39
e-mail messagescalendar items, creating from  172
e-mail messagescategories, assigning to  249
e-mail messagesCc fi eld  83, 142

e-mail messagescentering text in  47
e-mail messageschecking spelling/grammar in  41
e-mail messagesclosing  51
e-mail messagescomposing  38
e-mail messagescreating  44, 89
e-mail messagescutting text in  46
e-mail messagesdefi ned  504
e-mail messagesdeleting  272
e-mail messagesdeleting after replying to  258
e-mail messagesdigitally signing  421
e-mail messagesdisplaying unread  243
e-mail messagesencrypting  422
e-mail messagesentering text  91
e-mail messagesfi ltering  242
e-mail messagesfi nding  236
e-mail messagesfl agging for follow-up  202, 203
e-mail messagesfont, changing  47
e-mail messagesfont formatting options  47
e-mail messagesformatting text in  41, 348, 349
e-mail messagesgrouping  238, 239, 241
e-mail messagesgrouping by subject. See  

Conversation view
e-mail messagesheaders in  39, 43
e-mail messagesHTML format  87
e-mail messagesinserting items in  40
e-mail messageskeyboard shortcuts for creating  

44, 71
e-mail messagesmail merging  101
e-mail messagesmanaging  235. See  also 

Conversation view
e-mail messagesmarking as read  399
e-mail messagesmarking as read/unread  244
e-mail messagesmessage window appearance  37
e-mail messagesnotifi cation icon. See  New Mail 

Message icon
e-mail messagesopening  103, 110
e-mail messagespasting text into  46
e-mail messagespersonalizing  87
e-mail messagesPlain Text format  87
e-mail messagesprinting  268, 270
e-mail messagesreading  42
e-mail messagesrecalling  125
e-mail messagesreplacing  125
e-mail messagesresending  125
e-mail messagesrestrictions, setting  391
e-mail messagesRTF format  87
e-mail messagessave frequency, changing  488
e-mail messagessaving as drafts  88, 89
e-mail messagesscrolling through  113
e-mail messagesserver retention, setting  20
e-mail messagessorting  239, 240, 241
e-mail messagestasks, creating from  202, 203
e-mail messagestext effects  48
e-mail messagesunread  103
e-mail messagesviewing text of  103

528  Edit Business Card dialog box

z03i626904.indd   528z03i626904.indd   528 7/16/14   5:45 PM7/16/14   5:45 PM



e-mail servers
e-mail serversdefi ned  504
e-mail serversmessage retention, setting  20

e-mail signatures. See  signatures
e-mail trails

e-mail trailsdefi ned  504
embedding pictures in messages  362
emptying Deleted Items folder  272
encrypted connection not available error  17
encrypting data between Outlook and Exchange  

13
encryption  422. See  also digital IDs; digital 

signatures
encryptionapplying  422
encryptiondefi ned  504
encryptionfor all messages  422
encryptionicon for  422
encryptionS/MIME receipts, requesting  422

Encryption button  421
Encrypt Message Contents and Attachments 

button  422
end time (work week), defi ning  278
etiquette, e-mail  119
events

eventsall-day, creating  57
eventschanging to appointments  58
eventscreating  58, 173
eventscreating from e-mail messages  172
eventsdefi ned  173, 504
eventsentering details  173
eventsinviting attendees  58
eventsprivate  166
eventsrecurring  173, 174

event windows
event windowsdefi ned  504

Excel charts. See  charts
exceptions to rules, setting  405
Exchange accounts  4. See  also e-mail accounts

Exchange accountsconnecting to  4
Exchange accountsconnecting with local area 

network  14
Exchange accountsdial-up connections to  14
Exchange accountsmailboxes, specifying additional  

12
Exchange accountsmanually confi guring  11, 12
Exchange accountsrenaming  12
Exchange accountssettings, changing  434

Exchange address list. See  Global Address List 
(GAL)

Exchange server rules  400
exercise format  xviii
exiting Outlook  25
Expand button  320, 331
Expand button (Rules and Alerts dialog box)  405
Expand/Collapse button  242

Expand Contact Card button  115
Expand Conversation button  233
expanding Navigation Pane  458
expanding ribbon  50
expanding the ribbon  31
expanding To-Do Bar  460
Expand The Navigation Pane button  458
Expand the Ribbon button  31
Expand The Ribbon button  50
Expand the To-Do Bar button  460
exporting

exportingdigital IDs  418
exporting contact records  321, 322, 323
extensions, displaying  101

F
Favorite Folders

Favorite Foldersdisplaying  459
Favorites list

Favorites listadding folders to  35
faxes

faxescreating  89
faxeskeyboard shortcuts for  71

features and conventions of book  xix
Field Chooser dialog box  148
fi elds
fi eldsarrows next to  67
fi eldscustomizing  148, 150
fi eldssaving information in  39

fi le attachments. See  attachments
fi le extensions
fi le extensionsdisplaying  101

Filter dialog box  322
Filter E-mail button  242
fi ltering contact records  69, 145, 322, 334
fi ltering e-mail messages  242
fi ltering e-mail messagesremoving fi lters  243

fi ltering folders  322
fi ltering incoming messages. See  rules
fi ltering messages automatically. See  junk e-mail 

messages
fi nding e-mail messages. See  searching for e-mail 

messages
fi nding fi les  261
First Time Setup dialog box  259
fl agging messages
fl agging messageswith Quick Steps  464

fl agging messages for follow-up  202, 203
Flag Message dialog box  464
fl ags
fl agssetting  389

fl oating toolbars
fl oating toolbarsdefi ned  504
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fl owchart symbols. See  shapes
fl owing text
fl owing textaround pictures  363

Folder List
Folder Listdisplaying  311

Folder List button  35, 311
folder paths. See  paths
folders

foldersadding to Favorites list  35
foldersas address books. See  address books
folderscategories, assigning to  246
folderscollapsing  459
folderscreating  255, 309
foldersdefault  34
foldersdisplaying all  311
foldersfi ltering contents  322
foldersfi ltering messages into. See  rules
foldersfor tasks  226
foldersJunk E-Mail  408
foldersmanaging  37
foldersmessage organization and  254
foldersmoving messages into  256, 257, 258, 261
foldersnaming  309
foldersopening  311
folderspublic  430, 431, 432
foldersSearch Folders  264
folderssetting up  256
foldersswitching to  311
folderstypes of  254

Folders button  459
Folder tab (Calendar module)  52
Folder tab (Contacts module)  62
Folder tab (Mail module)  37
Folder tab (Tasks module)  74
follow-up fl ags

follow-up fl agsremoving  213
font. See  also text

fontchanging  47, 356, 360
fontcharacter spacing, changing  48
fontcolor, changing  49
fontdefault  348, 356
fontfor e-mail responses, specifying  348
fontformatting options  47
fontfor responses, setting  358
fontincreasing size  47
fontinstallation location  357
fontpreviewing  356, 357
fontselecting  356, 360
fontsmall caps, applying  49

Font arrow  360
Font button  47, 356
font color

font colordefault  356
font colorin automatic reply messages  444
font colorin business cards, changing  342
font colorselecting  358, 360

Font Color arrow  360
Font Color button  342, 444
Font dialog box  47, 48, 270, 356, 357
font size

font sizeselecting  358, 360
font style

font styleoptions for  349
format previewing. See  Live Preview; See  Live 

Preview
Format Text Effects dialog box  48
Format Text tab (contact record window)  65
formatting. See  also character formatting; text 

formatting
formattingclearing  50
formattingglobal. See  global formatting

formatting signatures  354, 360
formatting text  349
formatting text in e-mail messages  41. See  text 

formatting
forms

formscustomizing  500
formsdefault  500
formsoverview of  500

forms libraries
forms librariesaccessing  500
forms librariespersonal  500
forms librariesstandard  500

Forward button  123, 195, 217
Forward button (Help)  xxv
Forward Contact button  345
forwarding e-mail messages  119, 123

forwarding e-mail messagesclosing original 
message after  119

forwarding e-mail messagesprefi x used by Outlook 
for  123

forwarding messages
forwarding messagesfrom Junk E-Mail folder  410
forwarding messagespreventing  391
forwarding messagesrestricting  423, 424

forwarding tasks  217
From button  98

G
galleries

galleriesdefi ned  504
gallerieslive previews, enabling  483

Global Address List (GAL)  132
Global Address List (GAL)automatic update, 

turning off  440
Global Address List (GAL)defi ned  504
Global Address List (GAL)downloading local copy  

439
global formatting  350
graphics. See  Clip Art; See  pictures; See  SmartArt
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grouping calendar items  185
grouping contacts. See  contact groups
grouping e-mail messages  238, 239, 241, 390

grouping e-mail messagesexpanding/collapsing  
238, 242

groups, ribbon  31
groups, ribbonadding commands to  471
groups, ribboncommand display in  31
groups, ribboncreating  470
groups, ribbondefi ned  504
groups, ribbonexpanding  470
groups, ribbonmoving  470
groups, ribbonremoving  469
groups, ribbonrenaming  470

Grow Font button  47

H
Has Address button  335
headers, e-mail  39, 43

headers, e-mailAttached box  100
headers, e-mailfor meeting requests  56
headers, e-mailicons in  102
headers, e-mailinformation in  102

Help button  xxiii, xxiv, 31, 505
Help page (Backstage view)  30
Help window  xxiv

Help windowopening  31
navigating  xxv
printing from  xxvii
searching  xxvi
table of contents, displaying  xxv
topics, displaying  xxiv

hidden icons
hidden iconsdisplaying  400

hiding calendars  281
hiding program window  25
hiding To-Do Bar  61, 459
high importance. See  importance
holidays, adding to calendar  170
Home tab (Calendar module)  52
Home tab (Contacts module)  61
Home tab (Mail module)  36
Hotmail accounts

Hotmail accountsconnecting to  16
HTML (Hypertext Markup Language)

HTML (Hypertext Markup Language)defi ned  504
HTML message format  87
HTTP e-mail format

HTTP e-mail formatdefi ned  504
HTTP over RPC. See  Outlook Anywhere
Hypertext Markup Language. See  HTML message 

format

I
icons

iconshidden, displaying  400
identity theft. See  phishing messages
ignoring conversations  236
IM. See  instant messages
Image Align button  341
images. See  pictures
IMAP account

IMAP accountconfi guring Exchange account as, 
inadvertently  17

IMAP accountmanually confi guring  18
IMAP accounts  5
IMAP protocol

IMAP protocoldefi ned  505
importance

importancesetting  389
Import And Export Wizard  316
Import/Export Digital ID dialog box  418
importing

importingdigital IDs  418
importing calendars from Internet  281
importing data  314, 316, 317

importing datainto separate address book  314
importing datamapping custom fi elds  319

Import Outlook Data File Wizard  324
inactive buttons  45
Inbox  34

InboxCompact view  103
Inboxdisplaying  311
Inboxicons in  103
InboxPreview view  103, 106
InboxSingle view  103, 106
Inboxviewing  97

Info page (Backstage view)  30, 51
InfoPath forms  492
information bar. See  status bar
Information Rights Management (IRM)

Information Rights Management (IRM)defi ned  504
Information Rights Management (IRM)overview 

of  423
Insert Chart button  381
Insert Chart dialog box  381
Insert File dialog box  99, 100
Insert Picture dialog box  362, 371
installing

installingdigital certifi cates  17
installing add-ins  499
installing printers  268, 296
instant messages

instant messagesreplying to e-mail messages with  
120, 141

instant messaging
instant messagingdefi ned  504
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Instant Search  145. See  also searching for e-mail 
messages

Instant Searchautomatic fi ltering by  263
Instant Searchcriteria, specifying  266
Instant Searchdisplaying all search results  262
Instant Searchfor tasks  226
Instant Searchmaximum results listed  262
Instant Searchoverview of  261, 307, 333
Instant Searchrefi ning results  335
Instant Searchremoving criteria  336
Instant Searchrepeating searches  338
Instant Searchscope, setting  336
Instant Searchsearch criteria, specifying  262

Internet calendars  281
Internet calendarsconnecting to  283
Internet calendarsmodifying  283

Internet connection
Internet connectiondisconnecting Outlook from  

36
Internet Explorer dialog box  449
Internet Explorer Security dialog box  449
Internet Message Access Protocol (IMAP) accounts. 

See  IMAP accounts
invitations. See  meeting requests
Invite Attendees button  55, 58

J
jelly beans. See  presence icons
journal

journaloptions, setting  495
journal entries

journal entriesassigning to contacts  141
Junk button  410, 412
junk e-mail

junk e-maildefi ned  505
Junk E-mail folder  34
Junk E-Mail folder  408

Junk E-Mail folderdeleting messages from  410
Junk E-Mail folderdisplaying  409
Junk E-Mail foldersafety of messages in  409

junk e-mail messages. See  also phishing messages
junk e-mail messagesadding sender/recipient to 

Safe list  411
junk e-mail messagesdefault handling of  408
junk e-mail messagesdeleting  410
junk e-mail messagesdeleting automatically  413
junk e-mail messagesdisplaying  409
junk e-mail messagesfi ltering  408
junk e-mail messagesforwarding  410
junk e-mail messagesfrom country/domain, 

blocking  415
junk e-mail messagesmarking as Not Junk  411
junk e-mail messagesorange information bars  409
junk e-mail messagespictures in  425

junk e-mail messagesprocessing  410
junk e-mail messagesprotection level, setting  412
junk e-mail messagesrecipients, blocking  414
junk e-mail messagesresponding to  410
junk e-mail messagessenders, blocking  414
junk e-mail messagessettings for, changing  412
junk e-mail messagesspecifying senders/addresses 

as  408
junk e-mail messagesviewing information on  409

Junk E-mail Options dialog box  412, 413, 414, 415

K
Keep Changes button  375
keyboard shortcuts

keyboard shortcutsdefi ned  505
keyboard shortcutsfor appointments  55
keyboard shortcutsfor Calendar module  54
keyboard shortcutsfor color categories  245, 249
keyboard shortcutsfor Contacts module  66
keyboard shortcutsfor creating contact records  67
keyboard shortcutsfor creating e-mail messages  

44, 71
keyboard shortcutsfor creating tasks  77
keyboard shortcutsfor deleting categories  249
keyboard shortcutsfor displaying modules  27
keyboard shortcutsfor faxing contacts  71
keyboard shortcutsfor folder creation  255
keyboard shortcutsfor ignoring conversations  236
keyboard shortcutsfor marking messages as read/

unread  244
keyboard shortcutsfor Month view in Calendar  

192
keyboard shortcutsfor moving to end of message  

93
keyboard shortcutsfor permanently deleting 

messages  272
keyboard shortcutsfor redoing editing  374
keyboard shortcutsfor Schedule View  286
keyboard shortcutsfor Search Folder creation  264
keyboard shortcutsfor searching  265, 333
keyboard shortcutsfor searching with subfolders  

267
keyboard shortcutsfor sending e-mail messages  

89, 96
keyboard shortcutsfor To-Do Bar  26
keyboard shortcutsfor undoing editing  374
keyboard shortcutsfor validating e-mail addresses  

83
keyboard shortcutsfor Work Week view in 

Calendar  189
keyboard shortcutslist of  509

killfi les. See  rules
Knowledge Base  xxvii

532  Instant Search
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L
landscape orientation, setting  156
language packs  497
languages

languagesconfi guring  497
languages, blocking messages in  415
Layout button  341
Layouts gallery  386
legacy commands  33, 468
lists. See  also bulleted lists
List view (Calendar)  185
List view (contact records)  144
Live Preview  33

Live Previewdefi ned  505
local copy of mailbox  430
Location Information dialog box  132
lock icon  422
logon authentication methods  13
logon credentials, requiring  13
Lotus Organizer

Lotus Organizerimporting data from  314
low importance. See  importance

M
macros. See  Quick Steps
magnifi cation. See  zooming in/out

magnifi cationchanging globally  xvi
mailboxes, Exchange

mailboxes, Exchangespecifying additional  12
Mail button  311
Mail Folders

Mail Foldersdisplaying  459
mailing addresses, specifying in contact records  

135
mailing lists. See  contact groups
mail merging e-mail messages  101
Mail module  27, 34

Mail moduledisplaying  27
Mail modulemessage display in  36
Mail moduleribbon tabs in  36

Mail pane
Mail panedefi ned  505

Mail profi les. See  Outlook profi les
MailTips  333

MailTipscustomizing settings for  489
MailTips Options button  490
malicious e-mail messages. See  junk e-mail 

messages; phishing messages
Manage Rules & Alerts button  401
Map Custom Fields dialog box  319
Mark Areas To Keep button  375
Mark Areas to Remove button  374

Mark Complete button  213
marking messages as read

marking messages as readsettings for  112, 113
marking messages as read/unread  244, 399
marking tasks as complete  201, 205, 213
mathematical operators. See  shapes
measurement units, setting  485
Meeting button  141
meeting requests

meeting requestsaccepting  182
meeting requestsAppointment page  175
meeting requestsattendee availability, checking  

177
meeting requestsattendees  175
meeting requestsattendees, adding  177, 178, 179
meeting requestsattendees, optional  175
meeting requestschecking availability for  183
meeting requestscomponents of  176, 179
meeting requestscreating  178
meeting requestsdeclining  182
meeting requestsdefi ned  505
meeting requestsediting  181
meeting requestsoverview of  175
meeting requestsreplying to  121
meeting requestsrequired attendees  179
meeting requestsresponding to  182, 183
meeting requestsresponding to, manually  184
meeting requestsRoom Finder  177
meeting requestsscheduling  177, 179
meeting requestsScheduling Assistant page  176, 

177, 179
meeting requestssending  180
meeting requestssuggesting times in  177, 180, 

182, 184
meeting requestsTentative time  177

meetings
meetingscreating  55
meetingscreating from e-mail messages  172
meetingsdisplaying  286
meetingsduration, changing  177
meetingsheaders for  56
meetingsinviting attendees  55, 56
meetingsprivate  166
meetingsproposing new time for  184
meetingsreplying to e-mail messages with 

invitation  118
meetingsscheduling times for  57
meetingsstart time, changing  177
meetingstime zones, specifying  280
meetingsupdating  181

meeting windows
meeting windowsdefi ned  505

Members button  328
memos, printing contacts as  151
Message button  107
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message composition window  38
message composition windowappearance of  38
message composition windowBackstage view in  

39
message composition windowPeople Pane  39
message composition windowribbon in  40

message headers. See  headers, e-mail; See  e-mail 
headers

message list. See  Inbox
message lists. See  also e-mail messages

message listsalphabetical order, reversing  241
message listsarranging  237
message listsarranging by category  251
message listscolumns displayed in, changing  240
message listsviews for  237

message reading window  42
message reading windowappearance of  42

messages. See  e-mail messages
Message tab (message reading window)  44
message window

message windowappearance of  37
message windowcommands in  45
message windowdefi ned  505
message windowinactive buttons  45
message windowopening  44, 89

Microsoft Access
Microsoft Accessimporting data from  314

Microsoft Excel
Microsoft Excelimporting data from  314

Microsoft Exchange. See  Exchange accounts
Microsoft Exchange account settings dialog box  

12
Microsoft Exchange dialog box  11, 434
Microsoft InfoPath forms  492
Microsoft Knowledge Base  xxvii
Microsoft Offi ce Clipboard task pane  45
Microsoft Offi ce Web site

Microsoft Offi ce Web siteClip Art available on  364, 
365

Microsoft Outlook 2010. See  Outlook 2010
Microsoft Outlook 2010 Startup wizard  5, 6
Microsoft Outlook dialog box  149, 449
Microsoft Outlook Help button  xxiii, xxiv, 31
Microsoft PowerPoint presentations, previewing in 

Reading Pane  108
Microsoft Product Support Services  xxvii
Microsoft Word documents, sending via e-mail  99
Minimize button  25
Minimize The Navigation Pane button  458, 459
Minimize the Ribbon button  31, 50
Minimize the To-Do Bar button  97
minimizing Navigation Pane  458, 459
minimizing program window  25
minimizing ribbon  31
minimizing the ribbon  50

Mini Toolbar
Mini Toolbardisplay settings  483

Mobile Address Book  130
Mobile Address Bookdefi ned  505

mobile device messaging. See  text messages
mobile devices

mobile devicesoptions, setting  496
mobile devicestext messaging confi guration  496

module content pane  459
modules

modulesbuttons for  28
modulesdisplaying  27
modulesopening in new window  66
modulesopening two  66
modulesoverview of  27

Month button  192
Month view (Calendar)  186, 188, 192

Month view (Calendar)showing more/less detail 
in  193

More button (Layouts gallery)  385
More button (Picture Styles gallery)  377
More button (SmartArt Styles gallery)  386
mouse pointer alert  396
Move button  256, 312
Move Field Up button  343
Move Up button  470, 479
moving contact records  312, 313
moving desktop alerts  398
moving Offi ce content between programs  355
Multiple Pages button  270

N
naming folders  309
national holidays, adding to calendar  170
navigating e-mail messages

navigating e-mail messageskeyboard shortcuts 
for  93

Navigation Pane  26
Navigation Panedefi ned  505
Navigation Panedisplaying all folders in  311
Navigation Paneminimizing/expanding  458, 459
Navigation Panemodule buttons, modifying  458
Navigation Paneresizing  458

New Appointment button  55
New Calendar button  281
New Column dialog box  150
New Contact button  67, 133
New Contact Group button  327
New E-mail button  44, 89, 99, 361, 398, 477
New Folder button  255, 309, 432
New Items button  89, 201, 400
New Mail Message icon  396, 399
New Meeting button  178

534  message composition window
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New Search Folder dialog box  264
News Feed folder  35
New Task button  77, 200, 209
Next button (PowerPoint)  109
Next Slide button (PowerPoint)  109
Normal view (Calendar module)  52
Normal view (Contacts module)  61
Normal view (Mail module)  36
Normal view (Tasks module)  73
notes

notescreating  89
notesin tasks  208, 211
noteson contacts, recording  71
notesoptions, setting  495
notestasks, creating from  202

Notes folder
Notes foldercaching  435

Notes module
Notes moduledisplaying  27

notifi cations. See  alerts
No To-Do Bar view (Contacts module)  61

O
Offi ce.com Web site

Offi ce.com Web sitepublishing calendars to  288
Offi ce theme  351
Offl ine Address Book dialog box  441
offl ine address books

offl ine address booksdefi ned  505
Offl ine Server Documents  451
offl ine use of data fi le, disabling  14
offl ine working  430, 438

offl ine workingaddress book, accessing  439
offl ine workingediting fi les  451
offl ine workingmaking folders available when  433
offl ine workingstatus indicator  438
offl ine workingupdating address books  441

Open Calendar button  283
Open page (Backstage view)  30
optional attendees  175
Options button  398, 399
orientation, page  156
Outbox  35
Outlook

Outlookclosing  25
Outlookexiting  25
Outlooklogon credentials, requiring  13
Outlookstarting  6

Outlook 2010
Outlook 2010customizing program settings  482

Outlook Address Book
Outlook Address Bookdefi ned  505

Outlook Anywhere  4
Outlook Connector  16

Outlook Data Files
Outlook Data Filescreating  322, 323
Outlook Data Filesimporting  324

Outlook Data File Settings dialog box  14
Outlook Express

Outlook Expressimporting data from  314
Outlook Help button  xxiii, xxiv, 505
Outlook Help window  xxiv

navigating  xxv
printing from  xxvii
searching  xxvi
table of contents, displaying  xxv
topics, displaying  xxiv

Outlook icon  25
Outlook icondisplaying  400

Outlook Mobile Service account
Outlook Mobile Service accountMobile Address 

Book  130
Outlook Options dialog box  32, 59, 71, 78, 129, 

276, 277, 279, 348, 355, 397, 467, 469, 482
Outlook Options dialog boxAdd-Ins page  499
Outlook Options dialog boxAdvanced page  498
Outlook Options dialog boxCalendar page  493
Outlook Options dialog boxContacts page  494
Outlook Options dialog boxGeneral page  483
Outlook Options dialog boxLanguage page  497
Outlook Options dialog boxMail page  484
Outlook Options dialog boxMobile page  496
Outlook Options dialog boxNotes And Journal 

page  495
Outlook Options dialog boxSearch page  496
Outlook Options dialog boxTasks page  494

Outlook profi les
Outlook profi lesoverview of  5
Outlook profi lessetting up  5

Outlook Rich Text Format  505
Outlook Today

Outlook Todaydefi ned  505
Outlook Today page

Outlook Today pageTasks area  219
Out Of Offi ce Assistant. See  Automatic Replies
Out of Offi ce, marking time as  166
overlay mode (calendars)  285
Overtype mode

Overtype modeoptions for  485

P
page orientation, setting  156
pages

pagesoverview of  30
page setup

page setupcustomizing  155
page setupmodifying  270

Page Setup dialog box  300

 Page Setup dialog box  535
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paper size, selecting for printing  270
paragraph attributes

paragraph attributesoptions for  349
paragraph formatting  91
paragraph styles  349

paragraph stylesapplying  350
partner, adding to contact records  136
Paste Options button  46

Paste Options buttondisplay options for  492
Paste Options buttonsettings for  485

pasting text  46
pasting textoptions for  46

People Pane  39, 116
People Paneexpanding  116
People Panefi ltering item list  117
People Panetoggling between simple/detailed 

view  116
People Panetroubleshooting  117

Permission arrow  424
permissions

permissionsdefi ned  505
permissionsfor public folders  432
permissionssetting  423, 424

permissions, restricting  391
Personal Forms Library  500
personalizing e-mail messages  87
Personal sensitivity  389
phishing messages. See  also junk e-mail messages

phishing messagesdefi ned  505
phishing messagesdisabling links in  413
phishing messagesoverview of  408
phishing messagespink information bars  409
phishing messagesviewing  409

phishing sites
phishing sitesdefi ned  506

Phone button  147
phone directory, printing contacts as  151
phone numbers, entering in contact records  132
Phone view (contact records)  144

Phone view (contact records)switching to  147
photographs. See  pictures
Picture button  340, 362, 371
pictures. See  also Clip Art; See  also SmartArt

picturesadding to contacts  340
picturesartistic effects, applying  370, 378, 380
picturesaspect ratio, changing  376
picturesaspect ratio, maintaining  372, 377
picturesbackground, removing  372
picturesbackgrounds, removing  374, 375
picturescropping  377
picturesfl owing text around  363
picturesin business cards, aligning  341
picturesin e-mail messages, security of  425
picturesin responses  380
picturesinserting  362, 371

picturesinserting multiple  363
pictureskeeping changes  375
picturesmarking areas to keep  375
picturesmodifying  363, 370
picturesresizing  372, 376
picturesresizing when sending  101
picturesresponding to messages with  380
picturesstyles, applying  378

Picture Styles gallery  377
Picture Tools contextual tabs  370
plain-text fi les

plain-text fi lesdefi ned  506
Plain Text message format  87
plain text messages

plain text messagesdefi ned  506
plain text messagesreceiving by default  423
plain text messagessecurity of  423

pointing
pointingdefi ned  506

poll buttons. See  voting buttons
POP3 protocol

POP3 protocoldefi ned  506
POP account

POP accountconfi guring Exchange account as, 
inadvertently  17

POP accountmanually confi guring  18
POP accounts  5

POP accountse-mail message retention, setting  20
pop-up balloons. See  ScreenTips
popup tips. See  ScreenTips
pop-up window alerts. See  alerts
Post Offi ce Protocol (POP) accounts. See  POP 

accounts
PowerPoint presentations, previewing in Reading 

Pane  108
ppi settings  xvii
practice fi les  xxi
presence icon

presence icondefi ned  506
presence icons  114

presence iconsin enterprise environment  114
Presets button  49
previewing

previewingstyles  350
previewingstyle sets  352

previewing calendar  302
previewing fonts  356, 357
previewing formats. See  Live Preview; See  Live 

Preview
previewing items  26
previewing messages for printing  270
previewing printing  156
Preview pane  358
Preview view (Calendar)  185
Preview view (Inbox)  103, 106

536 paper size
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Print button  157
Print dialog box  155, 158, 269, 297, 300
printers, installing  268, 296
printing

Help topics  xxvii
printingaddress books  151, 152
printingcontact records  151, 152
printingselected items  159
printingsetting page orientation  156

printing calendar  295, 296
printing calendarin tri-fold style  303
printing calendarwith details  304

printing e-mail messages  268
printing e-mail messagespage setup, modifying  

270
printing e-mail messagespaper size, selecting  270
printing e-mail messagessettings for  269
printing e-mail messageswith headers/footers  271

printing messages
printing messagespreventing  391
printing messagesrestricting  423, 424

printing options  297
print options  300, 301
Print Options button  269, 297, 300, 304
Print page (Backstage view)  30
print preview  270
print styles

print stylesdefi ned  506
privacy

privacypictures in e-mail messages and  425
Private button  166
private calendar items  166
Private sensitivity  389
process diagrams

process diagramsinserting  383
process diagramslayout, changing  386

processing junk e-mail messages  410
profi les. See  Outlook profi les
program version numbers  314
program window

program windowareas in  458
program windowcustomizing  458
program windowhiding  25
program windowoverview of  24
program windowresizing  xv, 25

promoting list items  93
Properties dialog box  390, 432
Propose New Time dialog box  184
proposing new meeting time  184
public folders  430

public foldersadding to Favorites  433
public folderscreating  432
public folderspermissions, setting  432
public foldersstoring items in  431

Public Folders
Public Folderssearching  263

publishing calendars to Web  288, 293

Q
Quick Access Toolbar

Quick Access Toolbarbuttons, adding  474
Quick Access Toolbarbuttons, adding to  475, 477
Quick Access Toolbarbuttons, repositioning  479
Quick Access Toolbarbuttons, showing more of  

477
Quick Access Toolbarcommands, adding  33, 39
Quick Access Toolbarcommands, adding to  475, 

478
Quick Access Toolbarcustomizing  25, 475, 476
Quick Access Toolbardefault location of  474
Quick Access Toolbardefi ned  506
Quick Access Toolbarin message composition 

window  38
Quick Access Toolbarlegacy commands, adding  33
Quick Access Toolbarlists, adding to  475
Quick Access Toolbarmoving  474
Quick Access Toolbarmoving below ribbon  477, 

480
Quick Access Toolbarresetting to original 

confi guration  480
Quick Access Toolbarseparator, inserting  478

Quick Click category  246
Quick Click categoryassigning  246

Quick Step
Quick Stepdefi ned  506

Quick Steps
Quick Stepsaccessing  461
Quick Stepsactions, adding to  464
Quick Stepsactions available for  463
Quick Stepsactions, deleting  465
Quick Stepsapplying  260
Quick Stepscreating  462, 463, 464, 465
Quick StepsDone  258
Quick Stepsediting  259
Quick Stepsfl agging messages with  464
Quick Stepsfor multiple accounts  461
Quick Stepsmodifying  461
Quick StepsMove To  258
Quick Stepsoverview of  461
Quick StepsReply & Delete  258
Quick Stepsrunning  466
Quick StepsTeam E-mail  258
Quick StepsTo Manager  258

Quick Steps gallery  461
Quick Styles gallery

Quick Styles gallerypreviewing styles from  350

 Quick Styles gallery  537
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R
Reading Pane  26, 103

Reading Paneclosing  106, 460
Reading Panecustomizing  459
Reading Panedisplaying, in task lists  221
Reading Panemagnifi cation level, changing  111
Reading Panemarking messages as read  112, 113
Reading Panemoving  460
Reading Panepreviewing attachments in  104, 108
Reading Panescrolling in  113
Reading Panesettings, changing  486
Reading PaneSingle Key Reading  113

Reading Pane button  460, 486
Reading Pane dialog box  113, 486
Reading view

Reading viewswitching to  105
Reading View button  105
Reading view (Mail module)  36
Reading view (Tasks module)  73
recalling e-mail messages  125
recalling messages

recalling messagesdefi ned  506
Recall This Message dialog box  125
Recent Searches button  267, 338
recipients

recipientsadding contacts as  142
recipientsinvisible. See  Bcc fi eld
recipientsonline status  114
recipientspresence icons  114
recipientsQuick Steps for e-mailing  258
recipientsseparating with commas  85, 489
recipientsthumbnails for  116
recipientsvalidating. See  validating e-mail 

addresses
Recurrence button  168, 173
recurring

recurringdefi ned  506
recurring appointments  164, 168

recurring appointmentscreating  168
recurring events  173, 174
recurring tasks

recurring tasksmarking as complete  213
red ribbon icon  421
refi ning search results  335, 336
Reminder button  166
reminders

remindersdefi ned  506
remindersfor tasks  201
reminderssetting  389

Remove Background button  372
Remove button  336
removing fl agged items from task lists  213
removing follow-up fl ags  213
Rename dialog box  470, 472

renaming ribbon groups  470
renaming ribbon tabs  472
repeating editing

repeating editingkeyboard shortcut for  374
repeating searches  338
replacing e-mail messages  125
Reply button  122, 217
replying to e-mail messages  118, 122

replying to e-mail messagesautomatically. See  
Automatic Replies

replying to e-mail messagesclosing original 
message after  119

replying to e-mail messagesdeleting immediately 
after  258

replying to e-mail messagesdeleting messages 
after  258

replying to e-mail messagesetiquette of  119
replying to e-mail messagesprefi x used by Outlook 

for  123
replying to e-mail messageswith instant messages  

120, 141
replying to e-mail messageswith meeting 

invitation  118
replying to e-mail messageswith voting buttons  

121
replying to task requests  217
Required Attendee icon  179
required attendees (meeting requests)  179
requiring logon credentials  13
resending e-mail messages  125
resending messages

resending messagesdefi ned  506
resetting business cards  344
resetting Calendar view  190
resetting Quick Access Toolbar to original 

confi guration  480
resetting ribbon to original confi guration  474
resetting views  149
Reset View button  190, 243
resizing

resizingprogram window  25
resizing Navigation Pane  458
resizing pictures  372, 376
resizing pictures when sending  101
resizing program window  xv
resizing ribbon  xv
resizing SmartArt  385
resolution. See  screen resolution
resolving addresses  11
resolving e-mail addresses. See  validating e-mail 

addresses
resolving user names

resolving user namesdefi ned  506
responding to meeting requests  182, 183

responding to meeting requestsmanually  184

538  Reading Pane
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responses. See  also e-mail messages
responsesclosing original message window  487
responsescustomizing settings for  487
responsesfont, setting  358
responsesinserting automatic text before  487
responsespictures in  380
responsesspecifying font for  348
responsesto junk e-mail messages  410

Restore Down/Maximize button  25
restricting message permissions  391
restrictions

restrictionssetting  423, 424
restrictions, setting  391
resuming drafts  89, 91
Return To Task List button  216
Review tab (contact record window)  65
ribbon  25. See  also tabs, ribbon

ribbonbutton appearance  xiv
ribboncommands, adding  468, 471
ribboncommands on  xiii
ribboncontextual tabs  30
ribboncustomizing  467, 468, 469
ribbondecreasing width of  xiv
ribbondefi ned  506
ribbondialog box launcher  32
ribbondisplaying  477
ribbondynamic nature of  xiv
ribbonexpanding  31, 50
ribbonexpanding groups  470
ribbongroups, creating  470
ribbongroups, displaying all commands in  xiv
ribbonhidden groups, displaying  xv
ribbonin Contacts module  61
ribbonin message composition windows  39, 40
ribbonin Tasks module  73
ribbonlegacy commands, adding  468
ribbonminimizing  31, 50
ribbonmoving groups in  470
ribbonoverview of  xiii, 28, 467
ribbonremoving groups from  469
ribbonremoving tabs  469
ribbonrenaming groups  470
ribbonresetting to original confi guration  474
ribbontabs, creating  472
ribbonwidth, changing  xv

Rich Text Format. See  RTF message format
Rights Management (RM) account certifi cates  424
Room Finder

Room Finderhiding/displaying  177
Room Finder task pane  177
RSS Feeds folder  35
RTF message format  87
rules

rulesconditions, setting  403
rulescreating  401, 402, 403, 404, 405, 406

rulesdefi ned  506
ruleseffective only with Automatic Replies  442
rulesexceptions, setting  405
rulesExchange server  400
rulesrunning  406
rulestemplates for  402
ruleswith Automatic Replies, setting up  446

Rules And Alerts dialog box  401, 404, 406
Rules Wizard  401, 404, 406
running Quick Steps  466
running rules  406

S
Safe Recipients list

Safe Recipients listadding to  411, 414
Safe Senders list

Safe Senders listadding to  411, 413
Save button  88
Save & Close button  136, 167, 209, 212, 330, 344
Save & New arrow  137
saving drafts

saving draftsoptions for  488
saving e-mail messages  89
saving message drafts  88
saving messages

saving messagesautomatic settings  484
scam messages. See  phishing messages
Schedule View button  286
Schedule view (Calendar)  186
Scheduling Assistant button  56, 179
Scheduling Assistant page  176, 177, 179
scheduling meeting requests  177, 179

scheduling meeting requestsRoom Finder  177
scope, search  336
screen clippings. See  also screenshots

screen clippingscapturing  368, 369
screen magnifi cation, changing  xvi
screen resolution  xv

screen resolutionchanging  xvi
Screenshot button  367
screenshots. See  also screen clippings

screenshotscapturing  367
ScreenTips  xxiii

ScreenTipscustomizing display of  32
ScreenTipsdefi ned  506
ScreenTipsfor attachments  107
ScreenTipsfor buttons, displaying  32
ScreenTipskeyboard shortcuts in, setting  485
ScreenTipsstyle, setting  483

scrolling
scrollingin Reading Pane  113

Search Folders  35, 264
Search Foldersupdating  265

 Search Folders  539
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searching
searchingfor Clip Art  364

searching for contact records  307, 308, 333, 334
searching for contact recordscanceling search  335
searching for contact recordsin all items  336
searching for contact recordskeyboard shortcut 

for  333
searching for contact recordsrefi ning results  335
searching for contact recordsremoving search 

criteria  336
searching for contact recordsrepeating searches  

338
searching for e-mail messages  265. See  also 

Instant Search
searching for e-mail messagescriteria, specifying  

262, 266
searching for e-mail messagesdisplaying all search 

results  262
searching for e-mail messagesin Public Folders  

263
searching for e-mail messagesin subfolders  266
searching for e-mail messagesrepeating searches  

338
searching for e-mail messagessearch options, 

setting  496
searching for e-mail messagesviewing recent 

searches  267
searching for e-mail messageswith attachments  

263
searching for e-mail messageswith Search Folders  

264
searching Help  xxvi
Search More button  335
Search pane

Search paneclosing  335
Search Text dialog box  403
securing account data

securing account databy requiring logon 
credentials  13

security
securityof pictures in e-mail messages  425

security settings  417
selecting text

selecting textoptions for  485
Select Members dialog box  327
Select Name dialog box  143
Select Names dialog box  142
Send button  89, 96, 180, 218
senders

sendersblocking  414
senderscreating contacts from  139

sending e-mail messages  89
sending e-mail messagesdefault options, setting  

484

sending e-mail messagesfrom multiple e-mail 
accounts  98

sending e-mail messageskeyboard shortcut for  89, 
96

sending e-mail messagesQuick Steps for  258
sending e-mail messagesrecalling  125
sending e-mail messagesreplacing  125
sending e-mail messagesresending  125
sending e-mail messagesundoing  125
sending e-mail messageswhen offl ine  430

sending meeting requests  180
Send/Receive All Folders button  25
Send/Receive Groups button  439
Send/Receive Groups dialog box  439
Send/Receive Settings dialog box  440
Send/Receive tab (Calendar module)  52
Send/Receive tab (Contacts module)  62
Send/Receive tab (Mail module)  36
Send/Receive tab (Tasks module)  74
Send Status Report button  217
sensitivity

sensitivitysetting  389
Sent Items folder  34, 89

Sent Items folderviewing  97
sent messages

sent messagessave location, changing  89
sent messagesviewing  97

separated text fi les
separated text fi lesdefi ned  506

separator, inserting in Quick Access Toolbar  478
server certifi cate does not match site error  17
server rules

server rulesdefi ned  507
Service Sign-Up dialog box  424
Set Quick Click dialog box  203
setting up Outlook  5
Shape Height box  372
shapes

shapesadding to SmartArt graphics  385
shapesinserting  366

Shapes button  366
Share Calendar button  288
shared attachments

shared attachmentsdefi ned  507
shared folders

shared folderscaching  435
SharePoint

SharePointdocument libraries, caching  435
SharePointoverview of  448

SharePoint calendars
SharePoint calendarsconnecting to Outlook  453, 

454
SharePoint contacts list

SharePoint contacts listconnecting to Outlook  452
SharePoint document libraries

540  searching
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SharePoint document librariesconnecting to 
Outlook  448, 449

SharePoint document librariespreviewing items 
from  451

SharePoint document librariessubfolders  451
SharePoint document librariesworking offl ine  451

SharePoint Drafts folder  451
SharePoint List Options dialog box  449, 450
SharePoint Lists folder  450
sharing calendars  281, 288

sharing calendarsvia e-mail or Web  292, 293
sharing contacts folders  308
shortcut menus

shortcut menusdefi ned  507
shortcuts. See  keyboard shortcuts; See  keyboard 

shortcuts
Show As button  166
Show Columns dialog box  240
Show Hidden Icons button  400
Show Table of Contents button  xxv
Side-By-Side mode (calendars)  284
Signature button  355
signatures  88. See  also digital signatures

signaturesautomatically inserting  360
signaturesbusiness cards in  360
signaturescreating  353, 359, 360
signaturesdeleting from messages  355
signaturesediting  360
signaturesfor different e-mail accounts  354, 361
signaturesformatting  354, 360
signaturesinformation in  354
signaturesinserting manually  355
signaturesWordArt in  354

Signatures and Stationery dialog box  356
signing messages. See  digital signatures
Sign Message button  421
Single Key Reading  113
Single view (Inbox)  103, 106
slow connections, Cached Exchange Mode and  

436
small caps

small capsapplying  49
SmartArt. See  also pictures

SmartArtbullet points, adding  385
SmartArtcolors, changing  387
SmartArtcreating  381
SmartArtcustomizing  385
SmartArtinserting  383
SmartArtlayout, selecting  386
SmartArtnames, displaying  383
SmartArtresizing  385
SmartArtsending by e-mail  388
SmartArtshapes, adding  385
SmartArtstyles, applying  386
SmartArttext, entering  384
SmartArtText pane, displaying/hiding  384

SmartArt button  383
SmartArt Styles gallery  386
S/MIME receipts, requesting  422
S/MIME (Secure Multipurpose Internet Mail 

Extensions)
S/MIME (Secure Multipurpose Internet Mail 

Extensions)defi ned  506
SMS accounts  496
SMS messages. See  text messages
sorting contact records  147
sorting e-mail messages  239, 240, 241, 390
sounds, alert  396
spam. See  junk e-mail messages
spelling/grammar checker

spelling/grammar checkercustomizing settings for  
484

spelling/grammar checkerfor e-mail messages  41
spelling/grammar checkeroptions, setting  497

split conversations  233
spouse, adding to contact records  136
Standard Forms Library  500
stars and banners. See  shapes
starting Outlook  6
start time (work week), defi ning  278
Stationery and Fonts button  356
Stationery And Fonts dialog box  348
status bar

status barappearance of  26
status barclicking active items on  481
status barcustomizing  26, 481
status bardefi ned  507

status reports
status reportssending, on tasks  217

street addresses, entering in contact records  140
styles. See  also character styles; paragraph styles; 

See  also Quick Styles gallery
stylesfor pictures, applying  378
stylesfor SmartArt, applying  386
stylespreviewing  350

style sets  352
style setspreviewing  352

Styles pane  350
subfolders

subfolderssearching for messages in  266
Subject button  266
Suggested Contacts address book  130
Swap Time Zones button  280

T
Table button  93
Table gallery  93
table of contents

in Help window, displaying  xxv

 table of contents  541
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tables
tablesentering text in  94
tablesformatting  96
tablesinserting  93
tableslayout, selecting  93
tablesprinting contacts as  151
tablesstyle, changing  95

Table Styles gallery  95
tabs, ribbon. See  also ribbon

tabs, ribboncontextual  30, 93
tabs, ribboncreating  472
tabs, ribboncustomizing  468
tabs, ribbondefi ned  507
tabs, ribbonremoving  469
tabs, ribbonrenaming  472
tabs, ribbonstandard  30

task assignments
task assignmentsreplying to  121

task folders  226
task lists. See  also To-Do List

task listsDaily Task List  219
task listsdefault view  221
task listsdisplay of  26
task listsfl agged messages in  203
task listsmultiple  200
task listsReading Pane, displaying  221
task listsview, changing  224
task listsviewing  199
task listsviews for  220

task originator
task originatordefi ned  507

task owners
task ownersdefi ned  507

tasks
tasksaccepting  217
tasksassigning  214, 215, 217
tasksassigning to contacts  141
tasksCategory  202
taskscolors, changing  226
taskscreating  75, 77, 89, 200, 209
taskscreating from contacts  202
taskscreating from messages  202
taskscreating, from messages  203
taskscreating from notes  202
tasksdeclined, processing  215
tasksdeclining  217
tasksdeleting  201, 214
tasksdetails, showing  77
tasksDue date  201
tasksdue date, changing  201, 206, 208, 209, 211
tasksdue date, changing default  203
tasksdue today, viewing  219
tasksfi elds  77
tasksfi ltering  226
tasksfi nding  226

tasksforwarding  217
tasksicons for  207
tasksinformation in  201
tasksInstant Search  226
taskskeyboard shortcuts for creating  77
tasksmarking as complete  201, 205, 213
tasksmoving to new category  77
tasksnotes, adding  208
tasksnotes in  211
tasksopening  204, 211
tasksoptions  78, 201
tasksoptions, setting  494
tasksPriority  201
tasksPrivacy  202
tasksQuick Click fl ag  203
tasksRecurrence  201
tasksReminders  202
tasksreminders, setting  201, 209, 211
tasksreordering  221
tasksStart date  201
tasksstart date, changing  206, 211
tasksStatus  201
tasksstatus, changing  210, 211
tasksstatus reports, sending  217
tasksstatus, viewing  215
tasksview, changing  222

Tasks button  76, 206
Tasks folder

Tasks foldercaching  435
tasks list

tasks listdisplay of  73
Tasks List

Tasks Listchanging to  220
Tasks Listdefi ned  507
Tasks Listviewing  219

tasks lists
tasks listsfi elds in  201

Tasks module
Tasks moduleappearance of  76
Tasks modulecontent pane  73
Tasks modulecreating tasks in  200
Tasks moduledisplaying  27, 73
Tasks moduleopening  207
Tasks moduleribbon in  73
Tasks moduleviews in  73
Tasks moduleviews, switching  220

Tasks pane
Tasks panedefi ned  507

tasks, recurring
tasks, recurringmarking as complete  213

task windows  74
task windowsappearance of  74
task windowsdefi ned  507
task windowsopening  202

telephone numbers. See  phone numbers

542  tables
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templates, rule  402
Tentative availability  177
testing account settings  21
text. See  also font

textdefault appearance of  348
text effects

text effectsapplying  48, 49
text effectsdrop shadow  49
text effectsoptions for  349
text effectssmall caps  49

text formatting  348, 349. See  also character 
formatting

text formattingclearing  50
text messages

text messagesforwarding e-mail messages as  119
text messaging. See  mobile devices
text-only e-mail messages. See  Plain Text message 

format
Text pane

Text panefor SmartArt graphics, displaying/hiding  
384

Text Pane button  384
text wrapping breaks. See  line breaks
themes

themesapplying  351
themesapplying to all documents  349
themesdefault  348, 351
themesmodifying  352
themesoverview of  351

Themes gallery  351
threaded message view. See  Conversation view
threads

threadsdefi ned  507
thumbnails

thumbnailsgalleries of  504
time zones

time zoneschanging  279
time zonesdisplaying multiple  280
time zonesspecifying for appointments  280
time zonesspecifying, for appointments  165

Time Zones button  58
title bar  25

title bardefi ned  507
Today button  189
To-Do Bar  26. See  also task lists

To-Do Barclosing  97
To-Do Barcreating tasks in  201, 206
To-Do Barcustomizing  459
To-Do Bardisplaying  460
To-Do Bardragging messages to  203, 205
To-Do Barexpanding  460
To-Do Barhiding  61
To-Do Barkeyboard shortcuts for  26
To-Do Barminimizing  191
To-Do Baroptions, setting  460

To-Do Barshowing more appointments/tasks in  
460

To-Do BarTask List  199
To-Do Barviews, switching  219

To-Do Bar button  191, 460
To-Do Bar Options dialog box  460
To-Do Bar Task List

defi ned  507
To-Do Bar Tasks List

To-Do Bar Tasks Listcustomizing  219
To-Do List

defi ned  507
To-Do Listcreating tasks in  200
To-Do Listdisplaying  76
To-Do Listdisplay of  73
To-Do Listoverview of  199
To-Do Listresizing  205
To-Do Listviewing  219

Toggle button  116
toolbars. See  also ribbon; See  also specifi c 

toolbars; See  also specifi c toolbars
toolbarsfl oating  504

tracking messages  390
tracking messagessetting options for  491

tri-fold, printing calendar as  295, 303
troubleshooting

troubleshootingPeople Pane  117
Trust Center dialog box  417, 419, 421, 423

U
underlining text

underlining textoptions for  349
Undo button  50, 374
undoing changes

undoing changesto business cards  344
undoing editing  50

undoing editingkeyboard shortcut for  374
Undo/Redo button  25
unread messages  103

unread messagesdisplaying  243
unread messagesmarking as  244

Unread/Read button  244
updating meetings  181
updating task status  210
urgency. See  importance
URLs

URLsdefi ned  507
user-defi ned fi elds  150
user information

user informationsetting  483
user names

user namesresolving  11, 506
user profi les. See  Outlook profi les

 user profi les  543
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V
validating e-mail addresses  83

validating e-mail addressesaddress book search 
order, customizing  86

validating e-mail addresseskeyboard shortcut for  
83

validating e-mail addressestroubleshooting  84
version numbers  314
View in Overlay Mode button  285
View in Side-By-Side Mode button  285
View menu  459
views

viewsadvanced settings for  145
viewsBackstage  7
viewscolumn width, changing  149
viewscustomizing  145, 148
viewsdefi ned  507
viewsresetting  149

View Shortcuts toolbar  27
View Shortcuts toolbardefi ned  507

View tab (Calendar module)  53
View tab (Contacts module)  62
View tab (Mail module)  37
View tab (Tasks module)  74
virtual private network (VPN)

virtual private network (VPN)defi ned  507
virtual private network (VPN) connections  4
visual threads  233
Vote button  121
voting buttons  121, 390
VPN (virtual private network) connections  4

W
Web beacons

Web beaconsdefi ned  507
web logs. See  blogs
Web Page button  141
Week view (Calendar)  186, 187, 192
Windows Live Hotmail accounts

Windows Live Hotmail accountsconnecting to  16
Windows Mail

Windows Mailimporting data from  314
Windows Security dialog box  420
WordArt

WordArtin signatures  354
Word documents, sending via e-mail  99
working offl ine  430, 438

working offl ineaddress book, accessing  439
working offl ineediting fi les  451
working offl inemaking folders available when  433
working offl inestatus indicator  438
working offl ineupdating address books  441

Work Offl ine button  438
work week

work weekdefi ned  507
work weekdefi ning  276, 278
work weekdisplaying  276

Work Week button  189, 276, 287
Work Week view (Calendar)  186, 189

Work Week view (Calendar)keyboard shortcut for  
189

Z
Zoom button  27
Zoom dialog box  112
Zoom In button  146
zooming in/out  27, 286

zooming in/outin Reading Pane  111
zooming in/outof contact records  146
zooming in/outto actual page size  297

Zoom Level button  112
Zoom Out button  286
Zoom Slider  27

544  validating e-mail addresses
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